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ABOUT THIS MANUAL 

As you read through the manual, you will find information on how to configure features in the Urostym® 
software, as well as information on care and maintenance of the Urostym®. 

Throughout the manual you will also find specially marked sections that emphasize important reminders and 
information to help you understand the features of the system, as marked here: 

 

 

 

 

 

 

CAUTION 

Provides information users need to know in order to 
prevent minor injury or product damage. 

 

 

 

 

 

IMPORTANT 

Provides important information regarding use of 
device or software 

 

 

 

 

 

NOTE 

Provides useful information or reminders while 
operating the device or software. 
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1 INTRODUCTION 
The Urostym® Behavioral Therapy System offered by Laborie Medical Technologies provides the most current 
protocols for pelvic floor retraining. Reports are quickly and easily generated — providing complete patient 
information for analysis, treatment, and results. 

1.1  GENERAL DESCRIPTION 
Along with the features of the standard Urostym® Pelvic Muscle Rehabilitation (PMR) and stimulation capabilities, 
the software contains animation features to help keep a child’s or adult’s attention to facilitate their responses 
and participation in the rehabilitation process.  

1.2 MAIN FEATURES 
Some of the basic features of the Urostym® unit include: 

• Animation features 
• Multi-channel unit (2 EMG, 1 Electrical Stimulation, 1 Manometry) 
• Vaginal and anal Manometry 
• Internationally recognized standard protocols that are fully customizable 
• Computer-controlled probe detection for patient safety 
• Soft-ramping stimulation for patient comfort 
• Patient file preview for analysis 
• Tone sound during uroflowmetry/EMG sessions that changes pitch with muscle activity 
• Full color patient reports 
• Stand-alone unit with laptop computer 

Optional features include:  
• A variety of low cost probes and surface electrode patches 
• Uroflowmetry (voided volume and flow rate) with EMG (1 or 2 channels) 
• Integration with most LABORIE Urodynamic systems to enhance your pelvic floor center 

The following features are also supported in V7.0 and above: 
• Urostym® standalone 
• Electrical Stimulation  
• Linking with UDS Unit 
• Uroflowmetry (with UDS unit, Urocap™ or Uroflowmeter) 
• Notification section 
• PMR games 
• Questionnaire section 
• Pressure Manometry 
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1.3 CAUTIONS AND WARNINGS 

 
READ CAREFULLY BEFORE USE 

 

CAUTION 
United States Federal Law restricts this device to sale or use by, or on the order of, a licensed physician. 

 
GENERAL SYSTEM WARNINGS: 

• Only technicians and physicians trained in Urodynamics should operate this device. The operator must 
read the Owner’s manual entirely and refer to any additional training materials before using the device. 
Optional In-Service is available from LABORIE. 

• The Urostym® system and associated devices are intended for indoor use only under the following 
standard operating conditions:  

o Temperature: +10° C to +40° C  

o Humidity: 30% to 75% relative humidity 

o Pressure: 70 kPa to 106 kPa 

• And under the following transport and storage conditions: 

o Temperature: -29° C to +60° C  

o Humidity: uncontrolled to 85% relative humidity 

• The computer (printer and monitor, if applicable) MUST be used with LABORIE’s Line Isolation 
Transformer (LIT) in order to ensure safe operation and to meet safety regulations. 

• DO NOT USE in the presence of a flammable anesthetic mixture with air or with oxygen or nitrous oxide.  

• DO NOT USE the Urostym® in the presence of a magnetic resonance imaging system as it may contain 
ferromagnetic objects that pose a risk to the patient in the presence of a magnetic core.  The strong 
magnetic field produced by the MRI may cause disruption of the system.   

• DO NOT re-use probes between patients, re-use of probes creates a risk of cross-infection and/or cross 
transmission of infectious disease(s) from one patient to another.   

• The vaginal/rectal probes and the surface electrodes are delivered non-sterile and are intended for 
SINGLE PATIENT USE only. Probes must be cleaned between SINGLE PATIENT USES and disposed after 
single patient use is complete.  Cleaning instructions for probes are provided in this manual. 

• Simultaneous connection of a patient to high frequency surgical equipment may result in burns at the site 
of the stimulator electrodes and possible damage to the stimulator. 

• Application of electrodes near the thorax may increase risk of cardiac fibrillation. 

• DO NOT apply stimulation crossing over the heart, across or through the head, directly on the eyes, 
covering the mouth, on the front of the neck (especially the carotid sinus), or from electrodes placed on 
the chest and the upper back. 

• Operation in close proximity (1 meter) to shortwave or microwave therapy equipment may produce 
instability in the Stimulator output. 
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• DO NOT REPAIR the system by yourself or through an unauthorized party. Only LABORIE trained 
technicians may service the unit. Do not attempt to service system or any connected devise while system 
is in use with a patient. 

• LABORIE equipment and accessories are licensed/approved by Government and Safety Agencies to work 
with LABORIE equipment and accessories ONLY. 

• LABORIE equipment and accessories are warranted to work with LABORIE equipment and accessories 
ONLY. 

• LABORIE is not responsible for loss of patient files or test data. We recommend backing up patient data 
on a regular basis. 

• Any additional equipment connected to medical electrical equipment must comply with the respective 
IEC or ISO standards (e.g. IEC 60950 for data processing equipment). Avoid altering or adding to 
UROSTYM™ medical electrical system.  Any alteration to UROSTYM™ system by an unauthorized party 
transfers responsibility for meeting ME system requirements from LABORIE to the altering party.  Anyone 
connecting supplementary equipment to medical electrical equipment configures a medical system and 
is therefore responsible for ensuring that the system complies with the requirements for medical electrical 
systems, encompassed in the IEC 60601 series.”   

• No modification of this equipment allowed. 

• To prevent possible injury to the patient, ensure all castor wheels are locked during testing procedures 
(where applicable). 

• Use the UDS system with LABORIE equipment and accessories ONLY. 

• Device uses the general warning sign/symbol from EN ISO 15223 and ISO 7010.  Descriptions of all 
symbols that appear on the device and the device label can be found at the back of this manual. 

• Device does not have any protection against water ingress (IPX0). 

• To avoid risk of electric shock, this equipment must only be connected to a supply mains with protective 
earth. 

• To prevent tripping, all parts and accessories, including cables and cords, related to the Urostym® 
system should be kept appropriately tidy to ensure a safe environment. 

• Any additional Multiple Portable Socket Outlets (MPSO) or extension cord shall not be connected to the 
system. 

• Do not plug in any components or accessories supplied with the system directly into a wall outlet. Plug all 
components and accessories into the LIT. Failure to do so may result in damage to the system and void 
the system’s electrical isolation. 

• When a separate plug or appliance coupler is used as isolation means, the device shall remain readily 
operable. 

• Session results are for informational purposes only and must not be used exclusively for diagnostic 
purposes. 

• Local laws take priority over the above‐mentioned requirements and warnings. If in doubt, consult your 
local LABORIE representative or the technical service department. 
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IMPORTANT INFORMATION 

• Position the Urostym® unit close enough to keep the Urostym® Stop button within reach of the patient.  
Always place the unit to facilitate disconnection of device.  Device operator must be able to disconnect 
the device quickly and safely in the case of emergency.  

• LIT includes a circuit breaker that can easily reset in case of any short circuits or voltage surges. 

• Connecting electrical equipment to a multiple socket outlet effectively leads to creating a medical 
electrical system and can result in a reduced level of safety.  Only connect devices specified and 
approved by Laborie to GOBY™ multiple socket outlets. Connecting any device not approved by 
LABORIE to the ME system alters the functional integrity of the product creating a safety risk. 

• Ensure that the stimulation probe is handled with care since there is no automatic stop to stimulation if 
the probe slips out while still in stimulation ramp up or ramp down phase. 

• Always wear protective gloves. 

• Patients should be examined for any signs of skin and/or mucosal irritation prior to use. 

• The device must not be placed on the floor. It must be placed on a low cart or low shelf. 

• To ensure patient safety, operator must not simultaneously touch patient and any part of non-medical 
electrical equipment that come into contact during routine calibration and maintenance after the removal 
of covers and connectors. 

• Do not allow applied parts linked to a PATIENT CONNECTION, but not connected to the PATIENT, to 
contact other conductive parts including those connected to protective earth.  Preserve the patient 
connection electrical isolation. 
 

 
GENERAL SYSTEM SAFETY COMPLIANCE 

• To prevent electric shock, patients and equipment operators are protected in single fault conditions since 
resultant leakage currents fall well below acceptable standards for open ground conditions. This 
specification is conformant to EN 60601-1 (class 1 B) and CSA-22.2 (class 2/2G) standards.  It will not 
present any risk to the patient in either normal or ground fault conditions. 

• The device meets and exceeds the insulation breakdown specifications for both EN 60601-1 and CSA 
22.2 medical standards. Insulation is maintained by a combination of dielectric insulators and minimum 
physical separation (creep distances). 

• Device uses approved wire for connection, and adheres to EN 60601-1 air clearance and creepage 
distance requirements. 

• The Urostym® is a low-power electronic device for measurement purposes. Conforms to IEC EMC and 
EMI specifications for acceptable levels of radiated emissions. 

• The system already incorporates the use of individually approved EMC devices (power supplies, etc).  It is 
further improved at the design stage by shield cabling and inductor/choke placement to achieve the 
EMC conformance. 
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• The power entry module (connector for mains input) is rated as medical grade.  It meets IEC standards for 
insulation. The location of the power entry module is also situated in the back (or recessed) so that access 
to the connection point is reduced. 

• Software and firmware used in the final product are alpha tested in identical combination. Strict revision 
control and release control of Software and Firmware are established and followed. 

• To maintain connection, software contains built-in algorithms that add checksum (CRC) protocol to data 
transmissions. In the event that the data received is not correct, a finite number of re-transmissions are 
performed (typical 3 times) before a message is prompted to the operator. While the communication 
scheme is purely digital, the quality of the signal was enhanced by providing our own shielded 
connection cables of tested length.  Adheres to the PC standard for RS-232C pin-out specifications. 
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1.4 INTENDED USE 
The Urostym® Biofeedback and Stimulation Device is used for treating urinary incontinence by way of perineal re-
education. The Urostym® probes are non-implanted electrical devices applied to the pelvic floor musculature and 
surrounding structures for therapy in the treatment of urinary incontinence. The probes and patches are provided 
nonsterile for single (individual) patient use / disposable. The probes are for office or hospital use under the 
direction of a physician or other licensed healthcare professionals. 

1.5 TARGET POPULATION 
The target population for pelvic floor rehabilitation is extensive — both men and women of all ages may benefit 
from this form of treatment. Some of the dysfunctions that can be treated include: 

• stress urinary incontinence  
• urge urinary incontinence  
• mixed urinary incontinence  

Children who have the cognitive ability to listen to and follow instructions may benefit from pelvic floor therapy. 
Pediatric use of the Urostym® involves the use of EMG patches only, NOT probes. 

1.6 CONTRAINDICATIONS  
The Urostym® is contraindicated for any patient who is not a candidate for instrumentation. For example, 
probes should not be used with children. Patients who have implants or an implanted electronic device 
(like a cardiac pacemaker) should seek expert medical opinion before treatment. 

DO NOT USE Urostym® if the patient: 

• Has symptomatic UTI, fever 
• Has fecal impactions 
• Is too feeble, senile 
• Has menorrhagia 
• Has an infection of the bladder, vagina, rectum, or anus; or displays the symptoms of infection (such as 

itching, painful urination, sores, or fever) 
• Is pregnant, suspected to be pregnant or thinks she is pregnant. 

DO NOT USE the probes if the patient: 

• Has an anatomy that would make proper probe insertion difficult or impossible. 
• Has an infection of the bladder, vagina, rectum, or anus; or displays the symptoms of infection (such as 

itching, painful urination, sores, or fever). 
• Is a child, or considered as a pediatric patient. 

DO NOT USE stimulation if the patient: 

• Is pregnant, suspected to be pregnant or thinks she is pregnant. 
• Has colorectal or genitourinary cancer. 
• Has infection of the bladder, vagina, rectum, or anus; or displays the symptoms of infection (such as 

itching, painful urination, sores, or fever). 
• Has symptomatic UTI, fever 
• Has fecal impactions 
• Is too feeble, senile 
• Has menorrhagia 
• Has a pacemaker (patient should seek expert medical opinion before treatment) 
• Has defibrillator 
• Has a metal IUD 
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• Has rectal bleeding/swollen hemorrhoids (if using an anal probe) 
• Has cardiac arrhythmia 
• Had pelvic surgery in the last 6 months without primary surgeon’s permission 
• Has metal prosthetics in pelvic area (i.e., Hip implants) 
• Has seizure disorders 
• Has a pessary that contains metal. The pessary can be removed prior to start of session and replaced 

when session is complete. 
• Has cancer in the pelvic region (colorectal or genitourinary cancer) 
• Is a child, or considered a pediatric patient. 

 

For more information, please refer to the Patient Care Guide in the appendix at the back of this manual. 
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2 CLEANING AND PREVENTATIVE MAINTENANCE 
2.1 UROSTYM® UNIT 
The Urostym® unit is not immersible. It should be wiped down with a clean cloth dampened with a cleaning 
solution as per your facility’s cleaning instructions. 

Performing regular maintenance of your Urostym® system will reduce the need for costly repairs.  

The following schedule is recommended: 

• At startup of the Urostym® unit, assess all components are functioning:  
o Make sure the system is powered on before the laptop.  
o Make sure the laptop shows a green indicator light for Urostym® (and UDS if integrated).  
o Check the function of the probes. Squeeze the Manometry vaginal probe with your gloved hand 

(before insertion) and check for a response on screen; if no response is observed then channel 
accessories are not properly connected. Check accessory connections and test again. 

• Clean the ball inside the PC mouse at least once a year (if applicable). 
• The EMG and stimulation function is factory calibrated and does not require recalibration on a regular 

basis. If the calibration is found to be inaccurate after performing a calibration, please contact Laborie 
Medical Technologies. 

• (EMG Uroflow Option only) Calibrate only if the Uroflow transducer is off calibration. Check the 
calibration of the Uroflow transducer every 6 months.  

• The Uroflow beaker should be rinsed and dried after use. Soap and water, or a mild detergent solution, 
can be used for cleaning. 

 

Although the beaker is reusable, it will discolour over time and 
may need to be replaced. 

 

 

When cleaning the funnel, maximum cleaning temperature 
should not exceed 80 ̊C (176 ̊F). 

 

2.2 UROCAP™ III UROFLOWMETER 
The Urocap™ may become dirty due to urine contamination and cleaning will be required.  

ALWAYS WEAR PROTECTIVE GLOVES WHEN CLEANING THE EQUIPMENT TO PREVENT BIOLOGICAL 
CONTAMINATION. 

The exterior surface of the unit should be cleaned using a damp cloth with alcohol, soap, or disinfectant 
detergent. Wipe the surface dry immediately and do not let any liquid leak into the shaft that holds the dish. The 
unit should be stored in a cool and dry area. 

 

DO NOT SOAK THE UROCAP™ III IN WATER. DO NOT IMMERSE IN WATER OR ANY OTHER 
LIQUIDS. 

 

2.3 STIMULATION PROBES 
Refer to original manufacturer for cleaning validation details. 

Always wear protective gloves when cleaning to prevent biological contamination. 

Standard water-soluble lubricants (like K-Y® or Surgilube®) are not appropriate for use with EMG probes. Always 
use conductive gels (such as LABORIE’s ULT050 ultrasound gel) as lubrication. 
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The connection end of the cables must not come into contact with water. 

 
Condoms or other covers must never be used with EMG probes 

 

2.4 MANOMETRY PROBES 
The following materials and equipment are recommended for manometry probe cleaning, as per LABORIE’s 
cleaning validation test protocols: 

• Cleaning Agent: CaviWipesTM and ENZOL® 
• Disinfectant: Revital-Ox ResertTM HLD (Ready to use) 
• High-Level Disinfectant: CIDEX® Activated Dialdehyde Solution & Revital-Ox ResertTM HLD (Ready to use) 
• Soft lint-free cloth 
• Tap water 
• Basin 
• Appropriate personal protective equipment 

 

Any other cleaning and disinfectant products which have not been tested by LABORIE may not have 
the desired outcome, causing damage to the manometry probe materials and are therefore not 
recommended by the manufacturer. 

 

Manometry probes are intended for single patient use only.  Probes may NOT be used between 
patients.  Manometry Probes are provided non-sterile and must undergo high level disinfection 
before use. 

 

2.4.1 PRE-CLEANING 
After the procedure, perform the pre-cleaning step by wiping the manometry probes with a CaviWipe until visibly 
clean (for at least 20-30 seconds).   

2.4.2 CLEANING 
Following drying of the device, follow the below instructions for correct cleaning procedure. 

1. Immerse device in prepared ENZOL prepared to manufacturer’s specifications (59.14 mL detergent + 
7570 mL tap water) solution for one minute at 20-25  ̊C 

2. Use a soft, lint-free cloth while the device is immersed in detergent to remove any residues on the 
device  

3. Rinse under warm tap water (24-30  ̊C) for 60 seconds 

4. Wipe dry with soft lint-free cloth 

2.4.3 HIGH LEVEL DISINFECTION 
Following cleaning of the device, please follow the below instructions for High-Level Disinfection procedure. 

1. Prepare each disinfectant as per the manufacturer’s instructions. Ensure disinfectant used is above 
minimum recommended concentration (MRC) prior to use. 

2. When appropriate, pre-warm the disinfectant by using a water bath or incubator set above the 
minimum temperature requirement for the disinfectant. A warming pack, incubator or water bath may 
be used to maintain the desired temperature.  

3. Submerge the manometry probes in the prepared disinfectants accordingly: 

a. Using Revital-Ox Resert HLD: 
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i. Submerge the device in the solution for 8 minutes at 20 ± 2  ̊C.  

ii. Cover the basin during disinfection procedure. 

iii. Rinse with water for minimum of 1 minute 

iv. Wipe dry with soft lint-free cloth  

b. Using CIDEX® Activated Dialdehyde Solution 

i. Submerge the device in the prepared solution for 45 minutes at 25 ± 2  ̊C 

 
Refer to LABORIE Cleaning Validation Documents for full details. 

 

2.5 TREATING AND DISPOSING OF PRODUCTS AFTER USE 
After use, discard the contaminated, plastic, single-use disposables and any packaging according to your 
institution’s standard operating procedures on medical waste handling. 

For end of life product waste electrical and electronic equipment should be collected separately and returned to 
the designated local recycling service. 

Packaging waste should be collected separately for available national packaging collection and recycling services. 

2.6 COMPUTER VIRUS PROTECTION 
All computers purchased from LABORIE are virus-free before shipment and are installed with an Antivirus 
program. It is the customer’s responsibility to correctly use and maintain the antivirus program to prevent virus 
problems. LABORIE is not responsible for any virus-related computer problems after point of delivery to the 
customer. 

2.7 DATA BACKUP 
Check the space available on the computer’s hard disk at least every 6 months. Back up data from the 
UROSTYM® MDB file located in the Urostym® folder on the computer (C:\Program Files\Laborie Medical 
Technologies\Urostym\) on external media like CDs, DVDs or USB flash drives.  
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3 DEVICE SETUP 
To get up and running as quickly as possible, the following sections will outline the recommended setup 
procedures. 

3.1 PERFORM AN EQUIPMENT CHECK 
Verify that all ordered equipment and accessories have been received. Contact LABORIE if there are any 
discrepancies between ordered and received equipment. Inspect the equipment for any visible signs of damage 
or mishandling. Notify the carrier immediately if damage has been found. Carrying cases and cartons should be 
saved to provide a convenient and safe way to return the equipment should service be required. 

Standard Equipment 

• EQUIPMENT 
• Urostym® Unit 
• Computer Connection Cable (RS-232) 
• Channel 1 Cable (STIM/BIO) 
• Channel 2 Cable (EMG) 
• Channel 2, non-shielded, EMG, UDS 94 
• Vaginal Probe 
• Anal Probe 
• Virtual Software Key 
• Urostym® Software CD 
• Line Isolation Transformer (110V or 220V) 
• LIT Output Power Cord 
• Medical Grade Power Cord (110V or 220V) 
• Cable, Snap-on Filter 
• Cable, Urostym®, Channel 3 / Pressure Transducer 
• Re-closable Fastener Strips 

3.2 EQUIPMENT STATUS AND LIGHT SIGNALS 

3.2.1 INDICATOR SIGNALS 

Indicator LEDs provide important information on system readiness and device action.  Please see illumination 
descriptions below. 

Illuminations: 

Power on:  Please turn on the Urostym® using the power switch.  See section 3.2.2 Device Guide for a layout 
overview of all command buttons, channels and switches.  

During turn on, the Stop/Reset channel LED blinks six times then remains illuminated indicating the completion of 
a successful self test; the Urostym® is ready to use.  Please note that during the self test Manometry, and EMG 
Channels blink six times then turn off; while, the SIM/Bio Channel briefly illuminates yellow then sustains green.   

EMG & Manometry Activation: Selection of either EMG or Manometry functions in the application software will 
cause both channel LEDs to rapidly blink green signaling a ‘Ready’ state for information input. 

Stimulation Activation:  Selection of the Stimulation function in the application software will cause the channel 
LED to illuminate solid yellow for outputs over 4.5mA. 

Please see Troubleshooting on page 88 for further information. 
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3.2.2 DEVICE GUIDE 

Refer to Figure 1 and Figure 2 for an overview of controls and connections available on the Urostym®. 

FRONT FACING CONTROL PANEL: 

 

Figure 1: Urostym Device Guide – Font Facing Controls 

Note: Please reference 6.2 Urostym® Connection Diagrams for Adult Patients, of the “PATIENT CARE GUIDE” 
for further information on Urostym® channels. 

REAR FACING CONTROLS: 

 

Figure 2: Device Guide – Rear Facing Controls 
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3.3 USER REPLACEABLE FUSE 
STEP IMAGE  

1. Locate fuse housing on the rear panel of the Urostym® .  
Ensure the power switch is in the ‘off’ position. 

 
2. Using a non-conductive screwdriver, carefully open the fuse 

housing by pressing down lightly on the housing latch.  
Lower the housing panel to expose the red fuse carrier. 

 
3. Place the non-conductive screwdriver tip at the topmost 

edge of the fuse carrier and gently pry the carrier from the 
fuse housing.  Grasp the loosened fuse carrier and remove 
from the housing entirely.  Please note orientation of the 
fuse carrier. 

 
4. Remove fuses from the fuse carrier and insert replacements. 

Reinsert the fuse carrier into the housing and secure the 
housing panel latch. 

 

If the replacement fuse immediately burns out, move the power switch to the ‘off’ position and remove 
the power cord from the unit.  Contact your LABORIE Service representative for further instruction. 

Table 1: Replacing the Fuse 
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3.4 CART SET-UP 
Utilize the provided reclosable fastener strips to secure laptop and printer as part of Urostym® cart configuration.   
Recommended adhesion positioning for laptop: 

1. Apply re-closable fastener strips to the bottom of laptop. 
 

2. Flip laptop over so that the bottom of 
the laptop faces up. Locate two areas 
approximately ¼ and ¾ of the way 
along the laptop large enough to place 
the re-closable fastener strips so that 
they do not cover any vents or 
openings. Make sure both identified 
areas are clean so that a firm seal 
forms, if necessary use alcohol wipes to 
clean the laptop. 

 
3. Peel the protective cover away from one side of the re-closable faciner strip and place face down on 

the laptop in one of the two areas located above, hold the strip down for 30 seconds before releasing 
to ensure a frim seal forms. Repeat for the other piece re-closable fastener strip the second area 
notated above. 

 
4. Ensure the top of the Urostym® is clean 

and if necessary use alcohol wipes to 
clean the surface to ensure a firm seal. 
Peel the protective covering from the 
two reclosabel fastener strips and place 
the bottom of the laptop on the top of 
the Urostym® so that the centre of the 
laptop aligns with the centre of the 
Urostym®. Press down on the laptop 
for 30 seconds to ensure a good seal is 
formed. 

 
5. Ensure the laptop is secured to the Urostym® by attempting to slide the laptop along the Urostym®.  

If the laptop slides remove the laptop from the Urostym® and remove the re-closable fasteners 
applied.  Clean the areas with alcohol wipes and retry the procedure from step 2. 

 
Table 2: Cart Setup - Securing the Laptop 
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Recommended adhesion positioning for printer: 
 

1. Apply re-closable fastener strips to the bottom of the printer. 

2. Flip printer over so that the bottom of 
the printer faces up.  Locate 2 areas 
along the side of the printer large 
enough to place the re-closable 
fastener strips so that they do not 
cover any vents, gears or openings. 
Make sure all identified areas are clean 
so that a firm seal forms, if necessary 
use alcohol wipes to clean the printer. 

 

3. Peel the protective cover away from one side of the re-closable fastener strip and place face down on 
the printer in one of the areas located above, hold the tape down for 30 seconds before releasing to 
ensure a firm seal forms. Repeat for the second position notated above. 

4. Ensure the cart shelf is clean and if necessary use alcohol wipes to clean the surface to ensure a firm 
seal. Peel the protective covering from the re-closable fastener strips and place the bottom of the 
printer on the top of the cart shelf so that the back of the printer touches the back of the cart shelf. 
Press down on the printer for 30 seconds to ensure a firm seal forms. 

5. Ensure the printer is secured to the cart 
shelf by attempting to slide the printer 
along the shelf, if the printer slides 
remove the printer from the cart shelf, 
remove the pieces of Velcro tape from the 
printer and cart shelf, clean the areas with 
alcohol wipes and retry the procedure 
from step 2. 

 

Table 3: Cart Setup  - Securing the Printer  

3.5 WIRELESS PRINTER SETUP 
3.5.1 BEFORE YOU BEGIN 
Ensure the following: 

● The wireless network is set up and working properly. 

● The printer and the computers that use the printer are on the same network (subnet). 

While connecting the printer, you might be prompted to enter the wireless network name (SSID) and a wireless 
password. 

● The wireless network name is the name of your wireless network. 

● The wireless password prevents other people from connecting to your wireless network without your 
permission. Depending on the level of security required, your wireless network might use either a WPA 
passphrase or WEP key. 
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If you have not changed the network name or the security passkey since setting up your wireless network, you can 
sometimes find them on the back or side of the wireless router. 

If you cannot find the network name or the security password or cannot remember this information, see the 
documentation provided with your computer or with the wireless router. If you still cannot find this information, 
contact your network administrator or the person who set up the wireless network. 

3.5.2 SET UP THE PRINTER ON YOUR WIRELESS NETWORK 
To set up the printer on your wireless network use the Wireless Setup Wizard from the printer control panel 
display to set up wireless communication. 

1. On the printer control panel display, from the Home screen, touch  (Wireless). 
2. Touch  (Settings). 
3. Touch Wireless Setup Wizard or Wi-Fi Protected Setup. 
4. Follow the display instructions to complete the setup. 

If you are already using the printer with a different type of connection, such as a USB connection, follow the 
instructions in Change the connection type on page 29 to set up the printer on your wireless network. 

3.5.3 PRINT USING WI-FI DIRECT 
With Wi-Fi Direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-capable 
device—without connecting to an existing wireless network. 

Guidelines for Using Wi-Fi Direct 

• Make sure your computer or mobile device has the necessary software. 
o If you are using a computer, make sure you have installed the HP printer software. 
o If you have not installed the HP printer software on the computer, connect to Wi-Fi Direct first 

and then install the printer software.   Select Wireless when prompted by the printer software for 
a connection type. 

• Make sure Wi-Fi Direct for your printer is turned on. 
• Up to five computers and mobile devices can use the same Wi-Fi Direct connection. 
• Wi-Fi Direct can be used while the printer is also connected either to a computer using a USB cable or to 

a network using a wireless connection. 
• Wi-Fi Direct cannot be used to connect a computer, mobile device, or printer to the Internet. 

To Turn On Wi-Fi Direct 

1. On the printer control panel display, from the Home screen, touch  (Wi-Fi Direct). 
2. Touch  (Settings). 
3. If the display shows that Wi-Fi Direct is Off, touch the toggle button next to Wi-Fi Direct to turn it On. 

To Change Connection Method 

1. On the printer control panel display, from the Home screen, touch  (Wi-Fi Direct). 
2. Touch  (Settings). 
3. Touch Connection Method and then select Automatic or Manual. 

To Print From a Wireless-Capable Computer (Windows) 

4. Make sure you have turned on Wi-Fi Direct on the printer. 
5. Turn on the computer's Wi-Fi connection. For more information, see the documentation provided with the 

computer. 
6. From the computer, connect to a new network. Use the process you normally use to connect to a new 

wireless network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown such 
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as DIRECT-**- HP ENVY 5000 series (where ** are the unique characters to identify your printer).  Enter the 
Wi-Fi Direct password when prompted. 

NOTE: To obtain Wi-Fi Direct password, on the printer control panel display, from the Home screen, touch (Wi-Fi 
Direct). 

7. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless network. 
If the printer has been installed and connected to your computer with a USB cable, follow the steps below 
to install the printer software using the Wi-Fi Direct connection. 

a. Open the HP printer software. 
b. Click Tools. 
c. Click Device Setup & Software, and then select Connect a new device. 
d. When the Connection Options software screen appears, select Wireless. 
e. Select your HP printer from the detected printer list. 
f. Follow the onscreen instructions. 

8. Print your document. 

3.5.4 CHANGE THE CONNECTION TYPE 
After you have installed the HP printer software and connected the printer to your computer or to a network, you 
can use the software to change the connection type (for example, from a USB connection to a wireless 
connection). 

To Change From a USB Connection to a Wireless Network (Windows) 

1. Open the HP printer software.  
2. Click Tools. 
3. Click Device Setup & Software. 
4. Select Convert a USB connected device to wireless. Follow the onscreen instructions. 

To Change From a Wireless Connection to a USB Connection (Windows) 

Connect the printer and the computer with a USB cable. This USB port is at the rear of the printer. 

NOTE: A USB connection between the computer and printer can only be used if these two devices are isolated 
from the patient environment to reduce the risk of electric shock to the patient. Laborie highly recommends that 
a wireless connection is used between the computer and printer at all times. 
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4 SOFTWARE INSTALLATION AND SETUP 
For information on how to install the Urostym® software please refer to the Laborie System Installation Guide in 
the Laborie Software CD/DVD for detailed information. Remember that the software is factory-installed and 
should only be re-installed if it has been accidentally removed. 

4.1 SOFTWARE SETUP 
Any of the Urostym® channels (channels 1, 2 or 3) can be connected (or mapped) to one of the following devices:  

• Urostym® unit 
• UDS unit: Triton, Dorado KT (not the Urocap™) 

The Uroflowmeter can be connected to either the UDS unit or to the Urostym®. 

STEP IMAGE 
1 Start the Urostym® software by double 

clicking the Urostym® icon on the computer 
desktop. 

 

2 Click the Set COM button on the Urostym® 
toolbar. 

 
 

3 Select the Urostym® Unit check box, if not 
already checked, and then select the COM 
port that was used to connect the Urostym® 
unit (with the RS232 cables or the Belkin USB 
to Serial) to the computer.  
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3b To find available port(s) consult the 
Device Manager application by clicking the 
Device Manager button in the Set Com 
window and selecting the appropriate port. 

 
 

4 Click the Check Connection button and wait 
approximately 10 seconds.  
 
If the proper COM port was selected, the 
Urostym® connection indicator on the lower 
left of the Urostym® screen will change color 
to green. The COM Port for UDS section is 
for informational purposes only.  
 
*Configuration of UDS120 software should be 
performed with the UDS120 software according to 
the Laborie Software Installation Guide. 
 

 
 

5 If using a Uroflowmeter, click the 
Uroflowmeter Adjustment button to adjust 
the scale for the Flow and Volume channels. 
 

 
 

6 Click OK to save your scale selections.  
Table 4: Synergy Software Setup 

 

 

If your system was installed by Laborie Medical Technologies, the default COM ports used by the 
Urostym® and wired Urocap™ are COM1 and COM2 respectively. 
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4.1.1 SOFTWARE LOGIN 
Once the software starts, you may be asked to enter a user name and password. This logon feature, in 
accordance to the Health Insurance Portability and Accountability Act (HIPAA), provides an extra layer of security 
for testing and when accessing patient test files. 

 
Figure 3: Login Window 

The user name and password used for logging on to the 
computer must be used in this logon screen too (Figure 3).  
 
If a password is not available ask your system administrator 
to provide one for you. 
 
A log file is created whenever someone starts the software 
and opens a file.  
 

 

 

The software will shut down if an incorrect user name or password is repeatedly entered more than 
three times. 
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5 UROSTYM® SOFTWARE OVERVIEW 
The main Urostym® window is composed of four different sections (Figure 4): 

 
 

Main Menu Bar The main menu bar provides quick access to all functions. It contains the following submenus: 
File, Examination, Protocol, Options, Window and Help.  

Patient Toolbar The Patient Toolbar buttons provide quick access to the most frequently used functions.  

Patient List Button The Patient List button provides quick and easy viewing of patient folders.  These functions are 
also available through the main menu and the toolbar.  

Status Bar Along the bottom of the Urostym® welcome screen is a Status Bar that contains a Urostym® 
connection indicator, the UDS connection status, the Simulator connection status, the Clinic 
Name, the software version, the firmware version and the Notification indicator. 

Figure 4: Urostym® Main Software Window  
 

Mapped devices (also called connected devices) will be displayed in the status bar beside the device name. For 
example, on the bottom of the image above:   

• Channel 1 is linked to the Urostym® unit  
• Channel 2 (EMG1) and Manometry (transducer P4) are linked to the UDS unit  
• Uroflowmeter is linked to the Simulator (pseudo device) 

 

If a device is not linked, the indicator in the status bar is black; if the device is linked but not connected, 
the indicator is red; if the device is linked and connected, the indicator is green. 
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5.1 MAIN MENU BAR 
The Urostym® menu structure provides easy access to all software functions. 

5.1.1 FILE MENU 
The File menu is a top-level menu that provides all functions relating to patient records. 

New Patient Creates a new patient folder. Fill in the required information in the 
empty patient folder. 

Delete Patient Deletes the currently selected patient folder. When selected, a 
message will appear asking for verification of deletion. 

Delete Session Deletes the currently selected session in the Previous Session Folder. 
When selected, a message will appear asking for verification of 
deletion. 

Printer Setup Select printers installed on your computer or change the printer’s 
settings. 

Print Report Prints the selected Phase report. 

Import Protocols Allows for the exchange of protocols between different users. File 
exchange can only occur with files created by the same version of 
Urostym® software. Date and time of file creation will also be visible. 

Import Patient 
File from i-LIST 

Imports patient files from i-LIST database for easy selection. 

Exit Closes the Urostym® software.  

 

5.1.2 EXAMINATION MENU 
The Examination menu is a top-level menu that provides all the functions related to the examination session. 

Start Starts the selected session. Available in the patient folder when a 
session is selected from the Add New Session List. 

Stop Stops a running session. Available during an adjustment session or 
when an examination session is running. 

 

5.1.3 PROTOCOL MENU 
The Protocol menu is a top-level menu that provides all the functions related to Protocol programming.  

Program a Protocol Create, modify, copy, and/or delete a Protocol.   

Program a Current Create, modify, copy, and/or delete a Current.   

Program an Envelope Create, modify, copy, and/or delete an Envelope.   

Program a Template Create, modify, copy, and/or delete a Template.   
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5.1.4 OPTIONS MENU 
The Options menu is a top-level menu that offers the option of activating or deactivating available features. 

Show Hidden Protocols View all protocols, including hidden protocols, in the Protocol 
list. 

Animation Character and 
Background Music Options 

Change the animation and background music settings.  

Graph Configuration Change graph appearance such as curves, colors, and widths. 
Graph configurations can be set at a global or local level.  

Clinic Name When clinic name is added in this section, it will be included 
on all printed reports. 

EMG/Manometry 
Calibration 

Calibration of Channels 1, 2 and 3.  

 

5.1.5 WINDOWS MENU 
The Window menu provides display all open windows. Use the list to switch to the desired window. Each window 
is identified by window title. Also, pressing CTRL+F6 keys simultaneously will switch to another window. 

5.1.6 HELP MENU 
The About Urostym® menu option opens the window containing information about the software version, the 
firmware version, the support telephone numbers, and the website address. 

5.2 PATIENT TOOLBAR 
The Toolbar provides quick access buttons to frequently used functions. It contains some of the most common 
functions of the Urostym® software. 

 

Patient List The Patient List button switches the patient listing between the visible and the 
invisible modes. The first click prompts the patient list to appear; on the second 
click, the patient list disappears. 

To show the Patient List: 

• Click the Patient List button on the toolbar  
• To hide the Patient List: 
• When the patient list is visible, click the Patient List button to hide it  

-OR- 

 Click the X button in the upper-right side on the Patient List form. 

New Patient The New Patient button is a shortcut for the File > New Patient function, which is 
also accessible through the File menu on the main menu bar. 

Print The Print button is a shortcut to print reports. 
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Start 

 

The Start button is a shortcut to the Start function, which is also accessible 
through the Examination menu on the main menu bar. 

Stop The Stop button is a shortcut to the Stop function, which is also accessible 
through the Examination menu on the main menu bar. 

Set COM 

 

The Set COM button is a shortcut to the Map Devices and Com port setting that 
is performed when the Urostym® is initially set up.  

External Player 

 

The External Player button opens the Windows Media Player, which allows you to 
play CDs during a patient session or to build a music library with your choice of 
songs. 

Urgent Uroflow 

 

To be used for new patients only. Creates a new patient file with a unique ID, 
and adds all Uroflowmetry protocols to the Session List section.  

For existing patients, please select that patient from the Patient List and proceed 
to adding the protocols in the sessions tab.  

PFR 

 

To be used for new patients only. Creates a new patient file with a unique ID and 
adds all PFR protocols (PFR_EMG1EMG2AndManometry, 
PFR_EMG2AndManometry, PFR_EMG1AndEMG2, Alternating stimulation, and 
Continuous stimulation) to the Session List section.  

For existing patients, please select that patient from the Patient List and proceed 
to adding the protocols in the sessions tab 

Table 5: Patient Toolbar Settings 

5.3 PATIENT LIST AND PATIENT FOLDER 
The purpose of the Patient List is to list the patient files in the database, which includes patient name, date of 
birth, and date of most recent session. Click the headers to sort the records or use the filters at the top of the 
screen to further organize files (Figure 5). 

 

Figure 5: Patient List Window 
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A patient folder is the window displayed when you open a patient file or create a new patient file in the Patient 
List (Figure 6). 

 

Figure 6: Patient List -Patient Information Tab 
5.3.1 PATIENT INFORMATION TAB 
The Patient Information tab is used to enter personal information about the patient. 

Last Name* the patient’s last name 

First Name* the patient’s first name 

Birth Date* the patient’s date of birth 

Patient Number* the unique number used to identify the patient 

Sex* the patient’s gender 

Phone Number the patient’s contact phone number 

Alternate Number  the patient’s work phone number or an alternate contact number 

Doctor Last/First 
Name 

the doctor’s name 

Address the patient’s address 

Plan any relevant note(s) about the plans for treatment or a related 
subject 

Diagnosis any relevant note(s) about the patient or a related subject 

Visible select if the patient’s name is to be included in the Patient Tree 

Local Graph Options select this option to set up specific graph configurations for this 
patient only 

Save Click this button to save any new or edited patient information 

*Required Information 
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5.3.2 SESSIONS TAB 
The Sessions tab contains information about a patient’s treatment sessions (). The Session List contains 
treatments selected for the patient. The Used column indicates the number of times a specific session has been 
used on this patient. 

 

Figure 7: Patient List- Sessions Tab 
To add a new session to the Session List: 

1. Click a session from the Sessions Left listing at the bottom half of the screen. The session is highlighted in 
the listing. 

2. Click the Move To Session List button. 
3. Double-click any session in the Session List (or in the Sessions Left list) to see the Protocol information for 

that particular session. 

If necessary, click the Export button to set up the file (containing the protocols from the Session List) for use by 
another user. The file can then be imported by another user with the same version of Urostym® software. 

Saved Previous Sessions contains information on protocols used in previous visits.  

Game Score contains information on the results of a patient’s participation in the Urostym® video games. 
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5.3.3 QUESTIONNAIRE TAB 
The Questionnaire tab contains some of the most commonly used patient questionnaires such as: The Prolapse 
Quality of Life Symptom and Activities Questionnaires, The Kings’ Health Symptoms and Activities Questionnaires 
and the Urogenital Distress Inventory Questionnaire. 

Select either a specific questionnaire for each patient or use all of them. 

 
Figure 8: Patient List – Questionnaire 

Select to have all questions in a 
questionnaire visible or select to display 
a specific number of questions. To select 
specific questions click the Modify 
button to open the Questionnaire dialog 
box. Select the question that you would 
like to display and check the Visible 
option at the bottom of the dialog box. 
 

TO ADD QUESTIONS: 
1 Click the New button to open the 

Questionnaire form (Figure 8). 

 
 

2 Select the Page where you would like to add 
the question. 

3 Type the question in the Question Text line. 

4 Select the Question Type. 

5 Select the Question Order.  

6 Add the choices in the Question Item List. 

7 Select the Visible box if you want the question to appear at all times in the questionnaire. 

8 Click OK to add the newly created question to the Questionnaire Tab.  
• You can add as many questions as you like. 
• If you select to have a question in the Check or Radio format, you can have up to eight choices for 

the answers. 
• To make the question visible in the Questionnaire tab you will need to select the Visible check 

box. 
• Once you have created a question, it cannot be deleted or changed. If you do not want to include 

this question in the questionnaire, remove the check mark from the Visible check box. 
9 Click the Modify button to: 
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• change the Question Order (for example, if you want to move a question from the third spot in 
the list to the fifth spot) 

• make the question Visible or not 
• change the page where the question appears 

10 Click the Print Questionnaire button to obtain a printout of the questionnaire for a selected patient. 
Table 6: Questionnaire – Adding Questions 

 

5.3.4 NOTIFICATIONS TAB 
Click the Notifications tab in the patient file to add notes to a patient’s file (). The contents of the note can be 
added by typing in the Notifications text box. The notification icon  will be visible in the lower right corner of 
the Urostym® program on the date you have chosen.  
 

 
Figure 9: Patient List - Notifications Tab 

Click the New button to add a new 
note/message to the listing and to enter 
the date the notification should become 
visible. 
 
To edit a note, select the note requiring 
changes and then click the Modify button. 
 
To remove a note, select the note to be 
removed and then click the Delete button. 
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6 ADVANCED FEATURES 
6.1 DELETE A PATIENT FOLDER 

1. Open the desired folder. 
2. Click File > Delete Patient 
3. Confirm deletion by clicking yes in the resulting window 

 

 

Deleting a patient folder also deletes all related treatment sessions for this specific patient. Verify the 
selection of the patient folder to delete is correct before deleting. 

 

6.2 DELETE A PREVIOUS PATIENT SESSION 
1. Click the Sessions tab in the patient file. Click the Saved Previous Sessions tab to view the list of sessions 

saved with the patient’s file. 
2. Click on the line containing the session to be deleted. 
3. On the main menu bar click File > Delete Session. 
4. Click Yes to delete. 

 

6.3 CONFIGURING GRAPH APPEARANCE 
With this feature, you can set the color, line width, background, and grid properties of the graph area. 

To access the Graph Configuration window, Click Options on the menu bar and select Graph Configuration 
(Figure 10). 

 
Figure 10: Graph Configuration Window 

The Graph Configuration window contains five tabs: 
• Pelvic Muscle Rehab 
• Stimulation 
• Uroflowmetry 
• Grid Lines 
• PFR 
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6.3.1 PELVIC MUSCLE REHAB TAB 
This tab allows you to set the appearance of the PMR screens. Lines and curves in the graph area for Channels 1, 
2, and 3 can be modified to suit your preferences. A preview screen is available to help visualize your selections as 
you apply line widths and colors. 

Line Width: Move the slider pointer of the desired curve to modify the drawing width. Move it to the left 
for a narrower width or to the right for a wider width. 

 Line Color, Template Color, BG (background) Color: Double-click the desired colored rectangle 
 to display the color dialog box. The dialog box allows you to choose a color for each channel line, for the 
template and for the background of each channel. 

Fill in Curve Area:  Select this option to fill in the area under the PMR curve with the selected line color. 

6.3.2 STIMULATION TAB 
Select this tab to set the appearance of the stimulation screen. A preview screen is available to help visualize your 
selections as you apply line widths and colors. Double-click the desired colored rectangles to display the color 
dialog box. The dialog box allows you to choose a color for the specific section. 

6.3.3 UROFLOWMETRY TAB 
Select this tab to set the appearance of the Uroflowmetry screen.  You can modify the Volume and Flow curve 
colors, as well as the appearance of the channel curves and base line to suit your preferences. A preview window 
is available on the right-hand side of the screen to help visualize what your selections will look like on screen. 

 
If you choose to print your reports in color, the curves will be printed with the selected colors. 

 

6.3.4 GRID LINES TAB 
This tab allows you to set the color and style for the Grid Lines of the plotting area. 

Color: Double-click the desired colored rectangle to display the color dialog box. The dialog box allows 
you to choose a color for the line. 

Draw Style: Select the desired style to draw the grid lines in the plotting area. The default style is Solid, 
but you can also choose a Dash, Dot, Dash-Dot or Dash-Dot-Dot style. 

o To set draw style: Click the color box in the screen. 
o Select the Draw Style from the listing. 
o Click OK to apply your modifications. 

6.3.5 PFR TAB 
This tab allows you to set the color and style for the appearance of the PFR session curves. A preview window is 
available on the right-hand side of the screen to help visualize what your selections will look like on screen. 

SET DEFAULT VALUES BUTTON 
To restore default value settings, click the Set Default Values button to open the confirmation screen. Click Yes 
to go back to the default settings. 
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6.4 PROGRAMMING A PROTOCOL 
Click Protocol to display the menu for programming a protocol (Figure 11). 

 

If information is changed during Protocol creation, then you must click Update Phase, OK, and Yes 
when prompted to save the information. 

 
Figure 11: Protocol Window 

6.4.1 VIEW INFORMATION ABOUT A PROTOCOL 
1. Double-click the selected Protocol item from the Protocol List.  
2. View Sequence information. 
3. View Phase information.  

6.4.2 ADD NEW PROTOCOL 
1. Click the Protocol button on the toolbar.  
2. Click the New button on the right-hand side to open the Protocol Information window.  

 
Figure 12: Protocol Information Window 

The window contains the following information: 
• Name: Protocol Name 
• Duration: Protocol Length (using HH:MM). 

The max value is 30 minutes. 
• Protocol Description: Protocol Description 
• Special Comments: Comment related to the 

Protocol 
 

 
3. Enter the Protocol information. (The Protocol name must be entered.) 
4. Click the Save Sequence button. 
5. Add new Sequences and Phases for the Protocol.  
6. Click OK. 
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6.4.3 COPY INFORMATION FROM A PREDEFINED PROTOCOL 
This option will allow you to copy a predefined Protocol and modify it without altering the original Protocol. The 
name of the new Protocol will automatically be called “Copy of….” followed by the name of the original Protocol. 
The duration, name, description, and recommendation of the Protocol can be modified. 

1. Click the Protocol button on the toolbar.  
2. Select the protocol to copy from the Protocol List.  
3. Click the Copy button on the right-hand side.  
4. Click OK.  

  

6.4.4 MODIFY INFORMATION IN A USER-DEFINED PROTOCOL 
1. Click the Protocol button on the toolbar. 
2. Select the Protocol that you want to modify from the Protocol List.  
3. Click the Modify button. 
4. Modify information such as: Name, Duration, Protocol Description, and Special Comment. 

• Double-click the Sequence node on the Protocol Tree to modify the Repeat 
information. 

• Double-click the Phase node in Protocol Tree to modify the Phase information. Click 
OK. 

 

 

A Protocol can only be modified if: 
• It is a user-defined Protocol. 
• It is not in any patient’s Sessions List. 
• It has not been used in any Session for any patient. 

 

6.4.5 DELETE A USER-DEFINED PROTOCOL 
1. Click the Protocol button on the toolbar.  
2. Select the Protocol that you want to delete from the Protocol List.  
3. Click the Delete button.  
4. Verify that the Protocol selected for deletion is the correct one. 
5. Click Yes to delete. 

 
6.4.6 HIDE A PROTOCOL 
This function allows you to keep selected protocols hidden from the protocol listing. To hide the protocol, click 
the protocol name in the list and click the Hide button. To view hidden protocols, click Options > Show Hidden 
Protocols. 
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6.5 PROGRAMMING A SEQUENCE 
Important Sequence Terminology to remember: 

• Sequence No: (Sequence Number) The order of the Sequence in the Protocol 

• Repetition: How many times the particular Sequence will be repeated in the Protocol 

• Protocol Phase No: (Protocol Phase Number) The order of the Phase in the Protocol 

• Sequence Phase No: (Sequence Phase Number) The order of the Phase in the Sequence 

• Total Phase No: (Total Phase Number) Total number of Phases in the Protocol 

• Work Time: Duration of the work Phase  

• Rest Time: Duration of the rest Phase (Note: During the Session, Rest Time will always appear as a 
countdown clock on the screen) 

• Channel No: (Channel Number) The channel being used (channel 1, 2 or 3) 

• Channel Type: PMR (channels 1,2, and 3) or stimulation (channel 1) 

To create a Sequence, define the repetition of a Phase or a set of Phases. Sequences must be created before 
Phases can be created. 

The buttons at the top of this window help save, modify, and delete Sequences and Phases.  

 

Phases can be added to an existing Sequence. To do this, you must first select the Sequence you wish 
to modify, and then highlight the Phase within that Sequence to which you wish to add a Phase. The 
New Phase will be added immediately following the highlighted Phase. 

 

6.5.1 VIEW INFORMATION ABOUT A SEQUENCE 
Select the sequence from the Protocol Tree to view the information about the sequence (Figure 13). 

 
Figure 13: Protocol Information Window – Sequence  
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6.5.2 ADD A NEW SEQUENCE 
1. If a desired sequence already exists, select the Sequence in the Protocol Tree to which you want to 

add a new Sequence. 

2. If a sequence does not yet exist, click the flashing New Sequence button on the toolbar.  

3. Enter the Repeat Times and click the Save Sequence button. The new Sequence is added to the 
Protocol Tree. 

6.5.3 MODIFY INFORMATION IN A SEQUENCE 
1. Double-click the Sequence that you want to modify in the Protocol Information section. 

2. Modify the information in the Sequence Information section. 

3. Click Update Sequence.  

6.5.4 DELETE A SEQUENCE 
1. Select the Sequence that you want to delete in the Protocol Information section.  

 

Figure 14: Protocol Information Window – Delete icon 
2. Click the Delete Sequence button on the toolbar. 

3. Click Yes. 

6.6 PROGRAMMING A PHASE 
To view information about a phase: 

1. Click the plus sign (+) beside the Sequence in the Protocol Information section.  
2. Double-click the Phase you want to view. 
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6.6.1 ADD NEW PHASE 
Add a new Phase to the listing in the sequence (Table 7). 

1 Select the Phase or Sequence in the Protocol Information after which you want to add a new Phase. 

2 
Click the New Phase button on the toolbar.  

3 Enter the Phase information such as Phase Time* and Rest Time**. 

4 Select the type of phase. 

4a For PMR : Select  the Work Phase check 
box if phase is considered to be a work 
phase; specify what channels are to be 
used in the phase by checking off the 
appropriate channel check box; in 
selected channels select a template.  
 
Recommended use of channels: 

• Channel 1: For pelvic floor 
muscles; sensor: whether 
internal probe or surface 
electrodes 

• Channel 2: For abdominal 
muscle group; sensor: surface 
electrodes 

• Channel 3: For pelvic floor 
muscles; sensor: internal 
Manometry probe 

 
 

4b For Stimulation: select a Current and an 
Envelope.  
Stimulation must be used only on 
Channel 1. 

 
 

5 Click Save. 
* The Phase Time: Work time of the Phase. 
**The Rest Time: Rest time of the Phase. Appears as a countdown clock 
 

 

A Work Phase can be one of action (attempt to contract the pelvic floor) or relaxation (attempt to relax 
the pelvic floor). 

 

Table 7: Adding a New Phase in the Sequence 
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6.6.2 MODIFY INFORMATION ABOUT A PHASE 
1. Click the plus sign (+) beside the Sequence on the Protocol Tree.  

2. Double-click the Phase that you want to modify.  

6.6.3 MODIFY PHASE TIME AND REST TIME 
1. Click the combo box to select a different Template for the PMR channel, and/or Current and 

Envelope for the stimulation channel. 

2. Click Update Phase. 

3. Double-click the Phase that you just modified.  

6.6.4 DELETE A PHASE 
1. Select the Phase that you want to delete from the Protocol Information section. 

2. Click Delete > Phase on the menu bar  

3. Click Yes.  

6.7 PROGRAMMING CHANNELS 
The Table 8 contains the recommended setup for channels. 

Mode Channels Accessory 
Pressure PMR (Manometry) Use Channel 3 only Anal/Vaginal Manometry probe 
PMR Use Channels 1 and/or 2 Anal/Vaginal EMG probe; Surface electrodes  
Stimulation Use Channel 1 only Anal/Vaginal EMG probe; ELE625 Surface electrodes 

Table 8: Channel Setup 
6.7.1 PROGRAMMING A STIMULATION CHANNEL 

Important Stimulation Terminology to remember: 

• Current: Current used in the electrical stimulation Session. 
• Envelope: Displays the way in which electrical stimulation will be administered  
• Frequency: Current frequency  
• Modulation: Current uses a modulated frequency (for example: current fluctuates between two 

predetermined frequencies) 
• Pulse Width: Current pulse width, sometimes referred to as bandwidth 
• Plateau Value: Maximum current intensity in a stimulation envelope  
• Ramp Up Time: In a stimulation Envelope, time allocated for the current to ramp up (in seconds) to the 

Plateau value 
• Plateau Time: In a stimulation Envelope, time allocated for current remaining at maximum intensity 

(plateau period) 
• Ramp Down Time: In a stimulation Envelope, time allocated for current to ramp down to 0 
• Rest Time: In a stimulation Envelope, time allocated for resting (no current) within the Phase 

 
Only Channel 1 can be programmed for stimulation mode. 

1. Select the Stimulation Phase radio button to choose the Stim mode. 

2. Under Current, click the combo box and select a Current from the standard list. 

3. Click the Envelope combo box to choose one Envelope from the standard list.  
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6.7.2 PROGRAMMING A PMR CHANNEL 

Important PMR Terminology to remember: 

• Average Contraction: Average value of the patient’s contraction 
• Effort: The percentage of time a patient is able to remain within the template goal line during a particular 

phase. 
• Max Contraction: Maximum value of the patient’s contraction 
• Template: PMR profiles that appear on the screen during the patient Session. The Template acts as a 

goal line or target area the patient must attempt to reach. 

 
When programming a phase, Channels 1, 2, and 3 can be programmed for PMR mode.  

1. Select the PMR Phase radio button to choose the PMR mode. 

2. Specify the channels to be used in the phase 

3. Click the combo box under Template for each selected channel and choose one Template from the 
standard list. 

4. Enter all Phases and channel information as directed by the on-screen instructions.  

5. Click Update Phase to add it into the Protocol Tree. 

6.8 PROGRAMMING A CURRENT 
6.8.1 VIEW INFORMATION ABOUT A CURRENT 

1. Click Current on the main menu bar to display list. 

2. Select current to view. Selected current information is displayed in the picture box. 

6.8.2 ADD A NEW CURRENT 
1 Click the current button on the 

toolbar to display current list. 
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2 Enter a name for the new current. 
 
NOTE: Do not add any 
punctuation character to the name 

 
 

3 Click the up and down arrow buttons to increase or decrease the value of Frequency and Bandwidth and 
click OK.  
 
NOTE: The valid frequency range is 5-200 Hz. The valid pulse width range is 200-500us 

Table 9: Adding a New Current 

 

When defining Current with modulation in Frequency, two values are displayed on screen. These are 
Min Frequency and Max Frequency. The Min and Max Frequencies should have different values and 
the Min Frequency must be less than the Max Frequency. 

If you select Random Modulation, you are selecting to have a shuffled set of modulation sequences. For 
example, a set can contain a specific sequence with a set time between pulses. If you select to have random 
modulation, the time between pulses can be shuffled to provide a more effective type of treatment.  

6.8.3 MODIFY INFORMATION ABOUT A USER DEFINED CURRENT 
1. Select the current you want to modify from the Current List. 

2. Click the Modify button. 

3. Modify the current informations including Modulation, Frequency, and Width. 

4. Click OK. 

 
Only user-defined currents that have never been used in a patient session may be modified. 
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6.8.4 COPY CURRENT INFORMATION 
To copy the information from one current setup to another: 

1 Select the Current you want to 
copy. 

 
 

2 Click the copy button to open the 
Program Current window. 

 
 

3 Verify that the information is correct. If desired, change the name. Click OK when complete. 
Table 10: Copying Setup - Current 

6.8.5 DELETE A USER DEFINED CURRENT 
1. Select the current you wish to delete from the Current List. 

2. Click the Delete button. 

3. Click Yes in the resulting window to confirm deletion. 

6.9 PROGRAMMING AN ENVELOPE 
When programming a stimulation Envelope, you may include current ramping (Ramp-Up, Ramp-Down, Plateau) 
and rest time within each stimulation Phase. 

6.9.1 VIEWING INFORMATION ABOUT THE ENVELOPE 
1. Click Envelope on the main menu bar to display the envelope list. 

2. Select the Envelope you want to view from the list. 

6.9.2 ADD A NEW ENVELOPE 
1. Click Envelope on the main menu bar to display the envelope list. 

2. Click New. 



52  LABORIE Urostym® Owner’s Manual UST-UM07 

3. Enter the name of the new Envelope and click UP/DOWN buttons to increase or decrease section 
times in the envelope. 

4. Click OK. 

6.9.3 MODIFY INFORMATION IN A USER DEFINED ENVELOPE 
1. Select an Envelope that you want to modify from the Envelope List.  

2. Click Modify to display envelope information. 

3. Modify Envelope information including Ramp-Up, Plateau, Ramp-Down and Rest Time (in seconds). 

4. Click OK.  

6.9.4 COPY AN ENVELOPE 
1. Select the Envelope to copy. 

2. Click the Copy button to display the information window. 

3. Verify the information is correct. 

4. If desired, change the name. 

5. Click OK when complete. 

6.9.5 DELETE A USER DEFINED ENVELOPE 
1. Select an Envelope that you want to delete from the Envelope List.  

2. Click the Delete button. A confirmation message will appear. 

3. Click Yes.  

6.10 PROGRAMMING A TEMPLATE 
A Template is a PMR profile that illustrates the contraction or relaxation to be performed by the patient.  

6.10.1 VIEW INFORMATION ABOUT A TEMPLATE 
1 Click Template on the main menu 

bar to display the Template list. 

 

2 Select a template to view. 

Table 11: Viewing Template Information 

Create new Templates by clicking the Create a New Template By Scale button. Select a pre-configured 
Template to add to the Template list and/or change the scale value as necessary. A new pre-configured template 
will be created and added to the list.  
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You can also create a “No Template” Template by typing the number “0” into the Scale box and clicking the 
Create a New Template By Scale button.  

6.10.2 ADD A NEW TEMPLATE 
1 Click Template on the main menu 

bar to display the Template list. 

 

2 Click New Template. 

3 Using the grid, drag and drop the 
red or blue points to the desired 
position to draw the new template. 

4 Click OK. 

Table 12: Adding a New Template 

6.10.3 MODIFY INFORMATION IN A USER DEFINED TEMPLATE 
1. Select the Template to be modified from the Template List.  

2. Click the Modify button.  

3. Drag and drop the red and blue points to make the desired changes to the Template. 

4. Click OK.  

6.10.4 COPY A TEMPLATE 
1. Select the Template you want to copy. 

2. Click the Copy button. 

3. Verify that the information is correct. 

4. If desired, change the name. 

5. Click OK when complete. 

6.10.5 DELETE A USER DEFINED TEMPLATE 
1. Select a Template that you want to delete from the Template List. 

2. Click the Delete button.  

3. Click the Yes button to confirm.  
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6.11 VIEWING STATISTICS OF A SESSION 
1 When the session is complete, 

click YES in the resulting message 
box. 

 

2 The statistics of the session will be 
highlighted. 

3 Double-click the image to resize 
the phase and / or bar graph; this 
allows for easier viewing. Placing 
the cursor over a line produces the 
mA reading. 
 

4 Select Show Average next to the 
graph (it averages the phase 
report).  
OR 
Select Compare when two of the 
same reports are available for 
comparison 

Table 13: Viewing Session Statistics 
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7 PROTOCOL SETUP 
7.1 SAMPLE PMR PROTOCOL SETUP 

1.  On the main menu bar, click Protocol > Program a Protocol. 

2.  Click the New button. 

3.  Name the Protocol. (for example: Freework Bio Treatment) 
Click the Save Sequence button. 

4.  Type any desired information in the Protocol Information and Special Comments sections. 
 

5.  Under the Phase Information section, set the Phase Time to 10 seconds and the Rest Time to 0 seconds. 
 

6.  Under Channel Information select PMR Phase. 
 

7.  Select the Work Phase check box. 
 

8.  Select the Channel 1 check box and select Freework 50 to 100% from the drop down list under 
“Template”. 
 

9.  Select the Channel 2 check box and select Rest Inferior to 20% from the drop down list under 
“Template”. 
 

10.  Click the Save Phase button. 

 

11.  Under the Protocol Information section, 
highlight Phase No 1. 

12.  Click the flashing New Phase button 

13.  Leave the Phase Time at 10 seconds and 
leave the Rest Time at zero. 

14.  Under Channel Information select PMR 
Phase. 

15.  Select the Work Phase check box. 

16.  Select the Channel 1 check box and select 
Rest Inferior to 20% from the drop-down 
list under “Template”. 

17.  Select the Channel 2 check box and select 
Rest Inferior to 20% from the drop-down 
list under “Template”. 

 

18.  Click the Save Phase button 

19.  Under the Protocol Information section double-click Sequence No 1. 
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20.  Under the Sequence Information section, set the Repeat Time to 15. 

21.  Click the Update Sequence button   

22.  Under the Protocol Information section, you may add a Protocol Description and Special comments in the 
designated fields. 

23.  Click OK. 

Table 14: Sample PMR Protocol Setup Instructions 
 

7.2 SAMPLE ELECTRICAL STIMULATION PROTOCOL SETUP 
1.  On the main menu bar, click Protocol > Program a Protocol. 

2.  Click the New button. 

3.  Name the Protocol. (for example: Stimulation Treatment) 
Click the Save Sequence button. 

4.  Type any desired information in the Protocol Information and Special Comments sections. 

5.  Under the Phase Information section, set the Rest Time to 30; the stim envelope set the Work Time. 

6.  Under Channel Information select Stimulation Phase radio button. 

7.  Under the Current section, select the 50/50Hz – 300/300µs template, and under the Envelope 
section, select the 03.10.02.00 template. 

8.  Click the Save Phase button. 

 

9.  Under the Protocol Information 
section, highlight Sequence No 1. 

10.  Under the Sequence Information 
section, set the Repeat Time to 30 and 
click the Save Sequence button. 

11.  Click OK to confirm and exit. 

Table 15: Sample Electrical Stimulation Protocol Setup Instructions 
 

7.3 SAMPLE PMR AND ELECTRICAL STIMULATION PROTOCOL SETUP 
The following instructions outline the creation of a simple PMR and Electrical Stimulation Protocol. 
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7.3.1 CREATE A PMR SEQUENCE 
1. On the main menu bar, click Protocol > Program a Protocol. 
2. Click the New button. 
3. Name the Protocol. (for example: Freework Bio Treatment) 
4. Click the Save Sequence button. 
5. Type any desired information in the Protocol Information and Special Comments sections. 
6. Under the Phase Information section, set the Phase Time to 10 seconds and the Rest Time to 0 seconds. 
7. Under Channel Information select PMR Phase. 
8. Select the Work Phase check box. 
9. Select the Channel 1 check box and select Freework 50 to 100% from the drop-down list under 

“Template”. 
10. Select the Channel 2 check box and select Rest Inferior to 20% from the drop-down list under 

“Template”. 
11. Click the Save Phase button. 
12. Under the Protocol Information section, Double-click Sequence No. 1. 
13. Under sequence information, set the Repeat Time to 30 and click Update Sequence. 

 

7.3.2 CREATE A STIMULATION SEQUENCE 
1. Under the Protocol Information section, highlight Sequence No. 1. 
2. Click the New Sequence button. 
3. Under the Sequence Information section, Click the Save Sequence button. 
4. Under the Phase Information section, set the Rest Time to 30 seconds 
5. Under the Channel Information section select the Stimulation Phase radio button. 
6. Select 50/50Hz - 300µs from the drop-down list under “Current” and 03.10.02.00 from the drop-down list 

under “Envelope”. 
7. Click the Save Phase button. 
8. Under the Protocol Information section, double-click Sequence No 2. 
9. Under the Sequence Information section, set the Repeat Time to 15. 
10. Click Update Sequence. 
11. Click OK to confirm and exit. 
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8 USING THE UROSTYM® SOFTWARE 
Once you have made the connections to the correct Com ports, you can begin using the Urostym® software for 
PMR or Stimulation sessions. 

8.1 CREATING A NEW PATIENT RECORD 
1 Select the menu option File > New Patient,  click the New Patient button from the toolbar, OR press 

CTRL+N on the keyboard. 
 

2 Enter the Last Name, the First Name, the 
Patient Number, and the Birth Date in the 
boxes under the Patient Information tab. 
Remember to also select the gender of 
the patient. All other information is 
optional. 
 

 
 

3 Once all relevant information is added 
click the Save button to store the new 
information into the database. 

 
 

Table 16: Creating a new Patient Record – Instructions 
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8.2 CREATING A NEW SESSION 
To create a new session, you must add a new session to the session list. 

1 Open a patient folder 

 
 

2 Click the Add New Session tab 
under the Sessions tab. 
 

3 Select a Session from the Sessions 
Left listing. 
 

4 Click the Move To Session List 
button. 
 

Table 17: Creating/Adding a New Session 

8.3 STARTING A SESSION ACQUISITION 
8.3.1 SESSION ADJUSTMENT 
When starting a PMR session the Adjustment Session screen appears (Figure 15). When starting a stimulation 
session, the Transducer Detection window appears followed by the Stimulation Adjustment screen. For a 
session including PMR and stimulation, the PMR adjustment screens will appear first then the transducer 
detection and stimulation adjustment screen. 

PMR ADJUSTMENT 
The PMR adjustment screen allows you to evaluate the electrical activity of a muscular contraction. When asking 
the patient to carry out a maximum contraction, the contraction will act as a reference to test the muscle at 3/5 of 
its maximum strength and then adjust the channel scale accordingly. 

The adjustment screen contains a preview window that allows you to see what the template will look like during 
the session. A maximum of ten templates are listed in the preview area. 

 
Figure 15: Adjustment Session Window 
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• Max Scale: Recommended Values: Several parameters are available. Choose a scale for the sensitivity 
level with the slider or the buttons. For example: When 200µV is chosen, the base line will be 0 µV and the 
maximal scale will be 200µV. 

• Set Recommended Scale: Clicking this button sets the height to an ideal of 5% from the top and 10% 
from the bottom of the graph. 

• Restart Adjustment: Restarts the adjustment.  
• Next: When there are several PMR channels programmed in the Protocol, the Next button will 

independently adjust the Min and Max contraction value for the next channel. Upon reaching the last 
channel, clicking the Next button will launch the session. 

• Stop (On the Toolbar): This button cancels the session and brings you back to the Patient Folder screen. 

1. Ask the patient to relax the targeted muscle group as much as possible. 
2. Click the Move to Base Line button. 
3. Ask the patient to perform a strong contraction of the targeted muscle group. 
4.  Click the Set Recommended Scale button. 
5. Ask the patient to relax again and contract maximally the targeted muscle group. Make sure the maximum 

contraction is within the graph area. If it is not, start over at Step 1. 
6. Proceed to the next screen.  

STIMULATION MODE 
In a stimulation session, the Stimulation Adjustment screen allows for the adjustment of the current’s intensity 
level prior to launching the session and it must be adjusted to each individual’s need or sensitivity. 

Transducer detection will generate a small test current (up to 9 mA depending upon Probe detection signal 
strength). This is a normal testing/safety occurrence and may or may not be sensed by the patient.  

When starting a stimulation session, the Urostym® software runs a transducer detection test to verify that the 
Urostym® unit has been properly connected. The transducer detection applies to Channel 1 since it is the only 
channel capable of providing electrical stimulation (Figure 16).   

 

If the connection was not properly established, and after performing the transducer detection, a 
window will appear showing the connection status as OFF.  Make sure the probe and cables are 
properly connected, and then retest the connection. 

 

After performing the transducer detection, the connection indicator on the status bar will change from 
green to red if the unit is powered off or if the Urostym® unit has not been properly connected.  If this 
occurs, turn the device off, verify your connections, turn the device on again and restart the software.  
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Figure 16: Detection Connection Window 

Screen Buttons include: 
• Retest the Connection: click this to begin the transducer detection sequence again 
• Back to Session List: click this to cancel the Session and return to the Patient Folder 
• Next To Adjustment: click to go to session adjustment 

 
The Session Adjustment window appears (Figure 17). For Firmware 1.17 or later the maximum stimulation value 
is displayed (25 mA for anal probes or 70 mA for vaginal probes). 

 
Figure 17: Session Adjustment Window 

Screen Buttons include: 
• Restart Adjustment: This button allows you to retest the channel connection. 
• Next: If a Protocol has multiple Phases, this button will allow you to adjust the current’s intensity level 

for the next Phase. Upon reaching the last Phase in the Protocol, clicking the Next button will start the 
session. 

• Stop (on the Toolbar): This button cancels the session and brings you back to the Patient Folder 
screen. 
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The current’s intensity is adjusted by pressing the plus (STIM+) and minus (STIM-) buttons on the Urostym® unit. If 
you have Firmware 1.12 or later, you can click the blue Stim+ or Stim- buttons on the computer screen as well. 
The Phase No. (Phase Number), Channel, and Intensity degree are displayed on the window. 

As you adjust the Stim+ or Stim- buttons, the change in the current’s intensity level will be reflected in the vertical 
line height. This vertical line has a range of 0 to 25 mA for anal probes and 0 to 70 mA for vaginal probes and 
patch electrodes. 

NOTES: 
• For Firmware 1.15 or later: Press and hold the Stim+ button to increase the stimulation signal by 0.5 mA 

per 1 second. Press and hold the Stim- button to decrease the stimulation signal by 0.5 mA per 1 second. 
• Minimum time for increments/decrements is 0.5 sec; maximum time is 2.0 sec. To change time 

increments please contact the Laborie support team at 1-800-333-1039. 
 

 

During the session, the current’s intensity can only be adjusted when in the plateau period of a 
stimulation envelope. For safety reasons, current intensity may not be adjusted during ramping or 
resting. 

 

 

The WHITE Stop button on the front panel of the Urostym® is a safety feature allowing for rapid stop 
of current delivery.  Position the unit close enough to keep the button within reach of the patient. 

 

8.4 SESSION ACQUISITION 
The session acquisition can be started after adjustments are completed. Click Next to start session acquisition. 

  
Figure 18: Stimulation Phase Figure 19: PMR Phase 

 
The Session Screen contains the following toolbar options: 

 

STOP / START: Starts the session. If the session has already started, click this button to 
stop the session. Once you click the button to stop the session, a dialog box will appear. 
Select one of the options to either exit the session completely or to continue the 
procedure. 

  
PAUSE / RESTART Pauses the session (when colored green) or restarts the session (when 
colored red). 
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SKIP PHASE: Skips the current Phase and proceeds to the next Phase. 

 
SKIP SEQUENCE: Skips the current Sequence and proceeds to the next Sequence. If 
there is only one Sequence, this will end the session. 

 
Changes the default screen to the Animation screen. 

 
Displays graph curves. 

 
Background Music is ON. 

 

Opens the Animation Character and Background Music Option window for: 

• Selecting a different character for Channel 1 and/or Channel 2 
• Changing background music 
• Enabling or disabling the response character 
• Changing number of circles 

  
Audio feedback for Channel 1 and Channel 2 during Uroflowmetry. 

 
Increase or decrease the current’s intensity. 

Table 18: Session Screen – Toolbar Options Overview 

 
For a PMR phase, the Work Phase icon is displayed below the Phase Time clock at the top-right 
of the screen. 
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8.5 REVIEW A SESSION 
To view the results of a session click the Sessions tab in the patient file. Click the Saved Previous Sessions tab to 
open the following window. 

 
 

• COMMENTS BOX:  allows you to add notes 
to a selected session. Information added here 
will appear on the printed report. 

• GRAPH PREVIEW: Click the graph to open the 
Graph Preview window. Place the cursor on a 
wave in the graph to view the mA or H2O 
measurement.  

• SESSION TABLE: Click a session on the left 
side of the window to view the phase list of 
that session.  

• PHASE LIST: .If you click on a particular phase 
number (that is highlighted red) under Phase 
List, the graph will display the results for 
viewing and/or printing for this particular 
phase. 

 

Session 
Table 

Comments 
Box 

Graph 
Previews 

Phase 
Numbers 
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GRAPH PREVIEW 
• The EMG and Manometry complexes can be 

individually viewed by clicking the Next and 
Prev buttons. Note that only PMR phases are 
viewable in this window.  

• To view a close-up of a stimulation phase it 
will need to be selected from the Phase List 
in the main saved sessions tab. 

Click OK to close the window.  

 
Figure 20: Graph Preview Window 

 

GRAPH PREVIEW 
• Double-click the bar graphs on the 

bottom-left side of the screen to open 
the Graph preview window. 

Click the OK button to close the window or click 
the Print button to print the graph.  

 
Figure 21: Phase Effort Window 

 
When reviewing a saved session, three options are available: 

i) Show All Phases: This option shows all the saved Phases in the Phase List.  
ii) Show Average: This option calculates and displays the average value of all the repeated Phases within 

the current Protocol. Click the grid of the Phase List to review each individual Phase recorded in the 
database. 

iii) Compare <test 1> with <test 2>: This option calculates and displays the average values for two 
compared PMR sessions. (<test1> and <test2> represent the numbers in the text box). The two PMR 
session comparisons must be based on the same Protocol. 
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8.6 SETTING A LAG TIME OR A VOIDING SEGMENT AND INSERTING RESIDUAL VOLUME 
When performing Uroflowmetry sessions with EMG, you can select to have either a lag time or a Voiding Segment 
for calculations and reports. The Lag Time, or Voiding Segment, and PVR are set in the Graph Preview window. 

• Lag Time for Urostym® is the time from the start of pelvic floor relaxation to the start of flow. 
• Voiding Segments are portions of the graph that will be used for calculations and provide results in 

reports. This is useful to avoid miscalculations if, for example, a patient touched the beaker either before or after 
a Uroflowmetry test and it may have been recorded on the graph.  

• Post Void Residual (PVR) values can be typed into the PVR box and are included in all reports and review 
screens. 

 
To set a lag time: 

1 Double-click the Graph Preview window 
for a Uroflowmetry session with EMG 
channel(s) to open the enlarged Graph 
Preview window. 

 
 

2 In the Graph Preview window, select the 
Lag Time area by first clicking the Lag 
Time button. Then click on the graph 
where the lag time starts, and while 
holding down the left mouse button, drag 
the cursor from the left border to the right 
border of the desired area.  

 
 

3 Release the mouse button when desired area is selected. Add a PVR value if needed. 

4 Close the window by selecting OK and then click the Print button on the toolbar or the Print Phase Text 
Report button on the Patient folder.  

Table 19: Selecting Lag Time 
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To select a voiding segment: 
1 Double-click the Graph Preview window 

for a Uroflowmetry session with EMG 
channel(s) to open the enlarged Graph 
Preview window. 

 
 

2 In the Graph Preview window, select the 
Segment by first clicking the Segment 
Borders button. Then click on the graph 
where the desired segment for use in 
calculations starts, and while holding 
down the left mouse button, drag the 
cursor from the left border to the right 
border of the desired area.  The selected 
segment allows for removal of artifacts 
from the voiding picture. 

 
 

3 Release the mouse button when desired area is selected. Add a PVR value if needed. 

4 Close the window by selecting OK and then click the Print button on the toolbar or the Print Phase Text 
Report button on the Patient folder 

Table 20: Selecting a Voiding Segment 
The Lag Time, Segment, PVR value, and EMG Uroflowmetry information will be printed on the report as well as 
visible in the saved session window. 

8.7 PFR SESSION FUNCTIONS 
PFR sessions contain their own set of additional features and functions along with the features and functions of 
the general session protocols. 
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8.7.1 PFR SESSION BUTTONS 
Additional PFR session buttons include: 

 

Click the red Pause button to temporarily stop a session. The button color then changes to green. 
Click the green    Pause button to continue the session. 

 

Click to stop a session. 

 

Click to set the Manometry channel (if available) to zero without deleting the current session’s 
data. The Manometry calibration will be set to the current Manometry reading. 

 

Click to restart the session; also deletes the current session’s data. 

Click yes or no to confirm the restart. 

Table 21: PFR Session Button Overview 
 

8.7.2 PFR SUMMARY IN PATIENT FILE 
Under the Saved Previous Sessions tab the PFR Summary is displayed when a PFR session is selected (). 

 
Figure 22: PFR Summary 

The session parameters and the calculated Fatigue value are displayed. 
 

8.7.3 PFR REPORT PREVIEW 
Double-click the graph window in the summary tab to view an enlarged curve graph containing the complexes 
captured during a test.  

The preview contains Work Time information, allows for EMG and Manometry max scale changes, Zoom for 
specific complex ranges, and displays the Fatigue Point as calculated by the software. The Fatigue Point can be 
changed to a desired location by clicking on the displayed pint and dragging it to the desired location on the 
graph. (as illustrated in the following diagram) 
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Figure 23: Graph Preview Window - Complexes 

Use the control buttons on the bottom of the window to page through complexes and to select the print 
ranges and report types. 

 

8.7.4 PFR REPORTS 
When the Print complexes button is clicked in the Graph Preview window, a PFR Print Report Configurator 
window appears (Figure 24). Select the type(s) of report(s) to print as well as what type of information to include in 
a printout. 

 
Figure 24: PRF Print Report Configurator Window 
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REPORT TYPE SAMPLE PRINTOUT 
Graph Report 
Automatically contains: 

• PFR graphs with selected complexes and 
their numbers 

• Units of measure 
• Work time and total complexes 
• All parameters listed in the summary table 
• Comments 

 
 

EMG Evaluation Report 
Automatically contains: 

• total repetition 
• average value of work phases 
• maximum value of work phases 
• minimum value of work phases 

 
Selection of:  

• sensor placement 
• muscle reading 
• baseline consistency 
• PFR identification 
• Medically necessary training 
• Muscle activity 

 
 

Accessory Muscle Performance Measurement 
Automatically contains: 

• total repetition 
• average value of work phases 
• maximum value of work phases 
• session duration 

 
Selection of: 

• transverse abdominus muscle use 
• prognosis of therapy 
• exercise prescription 
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Anorectal Manometry Report 
Automatically contains: 

• total repetition 
• average value of work phases 
• maximum value of work phases 
• fatigue point calculated by the software 

 
Selection of: 

• muscle endurance evaluation 
• muscle type evaluation 
• muscle contraction holding ability 

 
Table 22: Report Types and Samples 

8.7.5 PFR REPORTS IN ILIST REPORTER 
If the Urostym® is linked to i-LIST Office Reporter and when a PFR session is complete, the i-LIST Reporter 
generates a report. The report contains PFR session information and the graphs with the number of repetitions. 

 
Figure 25: iList Office Reporter 
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8.8 CHANGING FLOW/VOLUME MAX SCALE FOR UROFLOWMETRY SESSIONS 
You can change the Flow/Volume maximum scale for completed sessions.  The Max Scale appears on the right in 
the Graph Preview window. 

To change the Flow/Volume Max Scale: 

1. Open a patient file and click the Sessions tab. 
2. Click the Saved Previous Sessions tab. 
3. Select the Uroflowmetry session for viewing.   
4. Click the Preview Picture box in the session to open the Graph Preview window.  
5. In the Graph Preview window, click either the Q (ml/s) or V (ml) label to open the Set Uroflowmetry 

Scales.  
6. Select new scale(s) and then click the OK button - the new Max Scales will be applied.  

8.9 CHANGING THE EMG MAX SCALE FOR UROFLOWMETRY SESSIONS WITH EMG CHANNELS 
You can change the EMG maximum scale(s) for saved or previous sessions. The Max Scale is changed in the 
Graph Preview window. 

To change the EMG Max Scale: 

1. Open a patient file and click the Sessions tab. 
2. Click the Saved Previous Sessions tab and select the Uroflowmetry session with EMG channel(s). 
3. Click the Preview Picture box to open the Graph Preview window.  
4. In the Graph Preview window, click the mV label to open the Set EMG Scales.  
5. Select new scale(s) and then click the OK button.  

Result: The new Max Scales will be applied. 

8.10 CHANGING THE UNIT OF MEASURE FOR MANOMETRY 
Pressure values can be displayed in either mmHg or cmH2O. 

To change the unit of measure: 

1. Click Options > EMG/Manometry Calibration. 
2. Select the preferred unit of measurement for Manometry. 
3. Click OK. 
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9 PRINTING SESSION REPORTS 
Depending on printer capabilities and settings, Urostym® reports can be printed in color or in black and white. 

After opening a Saved Previous Session under a selected Patient Folder, all previous sessions are loaded into the 
Sessions Table by date and time. 

Select the session you wish to print from the Sessions Table. 

9.1 INDIVIDUAL PHASE REPORTS 
1 Select the Show All Phase option to 

load all saved information. 

 
Example printout: Report for Beginner Incontinence Treatment 

2 Choose one item from the Phase 
List to display the graph of the 
selected channel. 

3 Click the Print button of the toolbar. 

Table 23: Printing Phase Reports 

9.2 REPORT AVERAGE 
1 Select the Show Average option. The 

summary information of the repeated 
channels is loaded into the Phase List. 

 
Example printout: Average Report with Evaluation of Pelvic 

Musculature Protocol 

2 Choose one item from the Phase List to 
display the graph of the selected channel. 

3 Click the Print button of the toolbar. 

Table 24: Printing Report Average 
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9.3 COMPARISON REPORTS 
1 Select a PMR session 

 
Example printout: Comparison Report for Incontinence start of 

treatment 

2 Select another PMR session to 
compare with the first. (Remember 
that this will only work if both PMR 
sessions use the same protocol. 

3 Select the Compare <1> with <2> 
option located at the bottom of the 
graph. 

4 Click the Print button on the toolbar. 

Table 25: Printing Comparison Reports 

9.4 PRINT PHASE TEST REPORT 
1 Select a PMR session 

 
Example printout: Phase Text Report for Incontinence end of 

treatment 

2 Click the Print Phase Text Report 
button. 

Table 26: Printing Phase Test Reports 
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9.5 USING I-LIST OFFICE REPORTER FOR UROSTYM® REPORTS 
If i-LIST Office reporter software is installed on the computer, the test results will open in a new window (Figure 
26). 

 
Figure 26: iList Reporter 

Click the print button on the toolbar to print a report. Note that PVR information added to a test file in 
Urostym® will be printed on the i-LIST report. 
Refer to the i-List Office Reporter Owner’s Manual for more information on selecting items to include in the 
printed reports. 
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10 ANIMATION AND PEDIATRIC APPLICATIONS 
The short attention span of children works well with the Laborie Urostym®. Pre-defined sessions and the ability to 
create individualized sessions of various lengths allow for stimulating sessions to maintain a child’s attention. Both 
the animation and video game options excite and delight children. Couple this with the feature of Score Keeping 
from session to session and it serves to motivate for self-improvement. Children are encouraged to do better 
each time.  

For evaluation of the voiding pattern, a Uroflow with 2 channel EMG offers assessment of both the pelvic and 
abdominal involvement along with the corresponding flow pattern. A full bladder is recommended as 
Uroflowmetry is best with greater than 100cc volume. The Auto Flow feature helps those with “shy bladder” as it 
keeps up to 5 seconds available prior to the start of voiding, dispensing with a long period of time up to voiding. 
Should Lag Time be desired, Auto Flow may not be advisable due to the 5 second limit. 

The starting point in Pediatrics is Uroflowmetry with one or both channels of EMG.  Select one or all of the 
following for the Patient Session List:  

1. Uroflow -  ([UroflowVol] with EMG 1 or 2 channel or without)   
2. Evaluation of Pelvic Floor Musculature. – ([UroflowCh1EMG] one channel, 10 minutes long) 
3. Pediatric -  ([Uroflow2EMG] 2 Channels, 10 minutes) 

10.1 SETTING ANIMATION CHARACTERS AND BACKGROUND MUSIC 
1 Start the Urostym® software by double-clicking the Urostym®.exe icon on the desktop 

2 Before a session is started, click 
Options and select Animation 
Character and Background Music 
Options. 
 
OR 

 
 

 During a session, click the Option 
menu and select Music Sprites 
Option. 
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3 Click to: 
• Enable animation and music 
• Select your preferred animation character for channels 1 and 2 
• Enable sound effect 
• Select your preferred background music 
• Enable or disable the response character 
• Change the number of circles displayed (for single channel protocols only) 
• Select to have a “Ding” sound that signals when a prize in the game is caught (for single-channel 

protocols only) 
 

4 Click OK to save your choices. 
-OR-  

Click Cancel to exit the screen. 
Table 27: Set Animation Characters and Background Music 

10.2 SCREEN FUNCTIONS 
BUTTON FUNCTION 

 
Stop a session 

 
Pause a session 

 
Skip to next Phase 

 
Skip to next Sequence 

 
Animation mode. 

 
Regular mode. (No characters or rings) 

 
Graph curves display. 

 
Graph curves removed. 

 
Background music ON. 

 
Background music OFF. 

 

• Select a different character for Channel 1 and/or Channel 2 
• Change background music 
• Enable or disabled response character 
• Change number of circles 

 
Start PMR Game 

Table 28: Screen Functions - Overview 
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10.3 PMR PROTOCOL SETUP FOR PEDIATRIC TESTING 
The following instructions outline the creation of a simple PMR Protocol that could be used with pediatric patients 
using two EMG channels. 

1 On the main menu bar, click Protocol > Program a Protocol. 

2 Click the New button and name the Protocol. (for example: Pediatric PMR Treatment) 

3 Click the Save Sequence button. Any Protocol Description and/or Special Comments may also be 
added at this time in the appropriate fields. 

4 Under the Phase Information section, set the Phase Time to 5 seconds and the Rest Time to 0 seconds 

5 Select PMR Phase and select the Work Phase check box. 

6 Select the Channel 1 check box. Select, for example, Freework 50 to 100% from the drop-down list under 
Template. 

7 If a second channel is desired, select the Channel 2 check box and select for example, Rest Inferior to 
20% from the drop-down list under Template.  

8 Click the Save Phase button. 

9 Under the Protocol Information section, highlight Phase No 1. 

10 Click the flashing New Phase button.   

11 Under Phase Information, set the Phase Time to 10 seconds and the Rest Time to 0 seconds. 

12 Select PMR Phase and select the Work Phase check box. 

13 Select the Channel 1 check box. 

14 Select Rest Inferior to 30% or Rest Inferior to 40% from the drop-down list under Template. 
If a second channel is desired, select the Channel 2 check box and Select Rest Inferior to 30% or Rest 
Inferior to 40% from the drop-down list under Template. 

15 Click the Save Phase button. 

16 Click Update Sequence and then click OK. 

Table 29: PMR Pediatric Protocol Setup Instructions 

 

The Work Phase is often kept short with pediatric patients since the emphasis is typically placed on 
pelvic floor relaxation. The countdown clock is not visible during a rest phase. 

 

10.3.1 IMPORTANT NOTES REGARDING PEDIATRIC PATIENTS 
• Children must often be taught how to relax the pelvic floor as well as how to contract (tighten) it. 

• When performing Uroflowmetry with EMG monitoring, the sound feature  provides audio feedback. 
With the contraction of the targeted muscle groups, the tone increases; and with relaxation, the tone 
decreases. 

• Only surface electrodes are used with pediatric patients. 
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10.4 STARTING A SESSION WITH ANIMATION 
1. Click Options and select Animation character and Background Music Options. 

2. Select Enable Animation and then select the animation for each channel at the top of the screen. 

3. Click OK. 

4. Choose a patient file in the Patient Tree.  

- OR -  

5. Create a New Patient file. 

6. Go to the Sessions tab. 

7. Start a PMR session from the Sessions List.  

10.5 STARTING A SESSION USING VIDEO GAMES 
1 Begin a PMR session. 

2 Once you have completed the 
adjustment screens and the session 
screen is visible click the Start 
Game icon on the toolbar. 
 

 

3 When in game mode, the PMR 
template is displayed as objects 
(bees, asteroids, jellyfish or bananas) 
crossing or dropping from the 
screen. 

  
 

  
Table 30: Starting a Session – Video Games 

Contracting the pelvic floor muscles will make the main character travel up (contraction) and down (relaxation) in 
these games.   The goal is to contract or relax the target muscle group in such a way that the Character can have 
successful contact with the moving objects. 

In the Monkey Dance game, contracting the pelvic floor muscles makes the monkey move to the right, relaxation 
makes the monkey move to the left. Abdominal activity will also affect the size of the tray; for example, increased 
abdominal activity makes the tray smaller. 
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Figure 27: PMR Template – Channels 

 
When using a protocol that includes Channel 2 (abdominal muscles), the template for Channel 2 will appear as 
a bar graph either on the side or bottom of the screen. The rectangular outline of the bar graph represents the 
template for the second channel, the solid color represents the patient’s abdominal muscular activity. The goal 
is to keep the muscle activity within the template. Increased abdominal muscle activity will increase the solid 
color bar within the template area. 

You can change the color of the bar graph by double-clicking it and selecting a new color from the color 
selection window. 

10.5.1 WAIT TIE DISPLAY 
During a Rest Time, a Wait message with countdown time will be displayed in the middle of the screen. 

 
Figure 28: Resting Countdown 

 
 

10.5.2 GAME SCORES 
To review the Game Score records look in the Game Score tab located in the Patient folder. Click the grid 
headers to sort the records by score or by date. 

Template for 
second channel 

Patient’s 
abdominal 
muscular activity 

Wait time 
count down 
message 
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Figure 29: Game Score Tab  

The scores are carried over from session to session. They act as a motivational tool and can help judge the 
progress of the patient over time. As each subsequent treatment session is successful, the score increases. 

 
10.5.3 GAME CONTROLS 

CONTROLS RESULT 

Contraction of pelvic floor The Fairy, UFO, or Fish moves up (vertical)  

The Monkey moves right (horizontal) 

Relaxation of pelvic floor The Fairy, UFO, or Fish moves down 

The Monkey moves left 

Fn+End button on the keyboard or 
the End button on an extended 
keyboard 

Slows down background image speed 

FN+Home button on the keyboard 
or Home button on an extended 
keyboard 

Speeds up background image speed 

Delete button on the keyboard  Slows down the target speed (bees, asteroids, jellyfish or 
bananas)  

Insert button on the keyboard  Speeds up the target speed (bees, asteroids, jellyfish or bananas) 
appearing on screen 

Table 31: Game Score Controls - Overview 
IMPORTANT: Increasing the target speed makes the game more difficult.  LABORIE does not recommend 
adjusting the speed of targets during the study; where possible determine target speed before beginning 
testing.  Do not use the speed change feature while training is in progress with a patient.  If speed adjustment is 
required during the study, notify the patient and use the indicated controls to decrease or increase speed.  Wait 
for all targets traveling at the previous speed to clear the screen before resuming training.  
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11 EMG AND UROFLOW SESSIONS 
Important Uroflowmetry Terminology to remember: 

• Flow: Urine flow rate (in ml/sec) 
• Volume: Voided volume (in ml) 
• Uroflow Lag Time: Time from the start of pelvic floor relaxation to the start of flow (in seconds) 

There are three predefined Uroflowmetry Protocols: 

UROFLOWMETRY PROTOCOL CHANNELS RECORDED 
UroflowCh1EMG Flow, Volume, EMG on Channel1 

uses one EMG channel (pelvic muscle) 

Uroflow2EMGS Flow, Volume, EMG on Channel1, EMG on Channel2 

uses two EMG channels (pelvic and abdominal) 

UroflowVol Flow, Volume 

does not use any EMG channels 

Table 32: Uroflowmetry Protocols 

All Uroflowmetry Protocols have the following pre-defined conditions: 

• All Uroflowmetry Protocols have a single Sequence made up of a single Phase. The Phase has a 30 
second work time and no rest time. The Sequence is repeated 50 times for a total of 1500 seconds (25 
minutes).  

 

Remember to position the beaker so that it is flat on the Uroflowmeter and to place the Uroflowmeter 
directly under the commode chair’s funnel. Nothing must touch the beaker or Uroflowmeter during 
testing. 

 

11.1 STARTING A UROFLOWMETRY SESSION 
1 Choose a patient file from the Patient Tree or create a new patient file. 

 
2 In the Add New Session tab, select either UroflowCh1EMG or Uroflow2EMGS or UroflowVol (the Type 

of Session is UroFlow). 
3 Click Move To Session List. 

4 Click the flashing Start button on the toolbar. The PMR Adjustment Screen will appear if the selected 
protocol is either UroflowCh1EMG or Uroflow2EMGS. In this window, you can set the base line and set 
the recommended scale for the selected session. 

5 Select Max Scale for EMG channels (if desired). 

6 Select Flow and Volume scales, appropriate for age of patient, on the Uroflowmetry Adjustment form. 
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7 Click the Set Zero buttons to set the Uroflow 
volume and flow channels to zero. 

 
 

8 Click the Next button. 

9 Use the following buttons as required: 

 
EMG sound is ON. Click the icon to 
turn the sound OFF.  

EMG sound is OFF. Click the icon to 
turn ON the sound. 

 
Click the red Pause button to 
temporarily stop a session.   

Click the green Pause button to 
continue the session. 

 
Click the Stop button to stop a 
session.  

Uroflowmeter is connected. 

 
Uroflowmeter is not connected. 

 
Click to set Flow channel to zero. 

 
Click to set Volume channel to zero.   

Table 33: Starting a Uroflowmetry Session – Instructions 

11.2 CHANGE VOLUME SCALE DURING A SESSION 
The Volume scale can be set to 50, 100, 150, 200, 250, 300, 500, 800, and 1000 ml. 

1. Click Option > Volume Scale to open the Set Uroflowmetry Scales window. 
2. Select one of the scale values for the individual patient. 
3. Click OK when finished. 

11.3 CHANGE THE VOLUME AND FLOW SCALE IN A SAVED SESSION 
1. Click the picture box in the Patient Folder under the Saved Previous Sessions tab to enlarge the graph. 
2. Click either the Q(ml/s) or V(ml) label on the Graph Preview window. 
3. Select one of the scale values. 
4. Click OK to finish. 
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11.4 AUTO-START 

 

Use of AutoStart is not recommended if you wish to monitor pelvic floor activity BEFORE actual voiding 
begins, or if you wish to calculate Lag Time measurements. AutoStart allows for a buffer of 15 seconds 
prior to void. 

You can select to have the Uroflow session start automatically when urine flow is detected by selecting the Auto 
Start button on the toolbar ().  

 

Figure 30: Tool Bar – Auto Start 

When selecting AUTOSTART, keep in mind the time buffer is 15 seconds, consider if this amount of time allows 
for full evaluation of pelvic and accessory muscles use prior to voiding.  In that case, do not select. 

Once the beaker has settled, the session automatically starts if an increase in volume is detected. The session will 
automatically stop 50 seconds after the urine flow stops.  In pediatrics, the lag time feature may be affected when 
Auto Start is used as this allows for a maximum of 15 seconds done before start of flow.  Should lag time be 
greater, it will not be on the screen for measurement. 

11.5 URGENT UROFLOW 
It is intended for new patients, those not already entered in the system. Once selected, three sessions are 
available: Uroflow2EMG, Uroflow1EMG and Uroflow/Vol.  

Important points to remember about urgent Uroflow: 
• If using EMG, quickly place on the patient. 
• As this is Urgent, and to bypass adjustment screens, select Next and Next to obtain the testing phase. 
• Allow patient to void. 
• At end of testing, select the Saved Previous Sessions tab to access the voiding graph.  Click on the 

graph to enlarge and address the scaling for EMG and Flow/Volume by selecting from the right margin: 
uV and Q (ml/sec). See page 41 for more information. 

• The patient’s name and all mandatory fields are indicated or held by a dash and simulated dates; these 
must be changed or repopulated with accurate patient information. 

• If the patient is already in the system, do not use Urgent Uroflow.  Select the patient name and start the 
desired Uroflow session prior to the patient’s arrival.  Do as instructed in step 2 by selecting Next and 
Next to get to the voiding screen.  Follow with steps 3 and 4 for completion. 
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11.6 ANIMATION OPTION FOR UROFLOWMETRY 
With the animation option enabled, the animation character will be visible on-screen once the Flow value exceeds 
the value that is selected on the flow scale.  

 
Figure 31” Uroflowmetry Scale with 

Animation 
 

 
Figure 32: Uroflowmetry Scale without 

Animation 
 

For example, if 5 ml/s is selected on the uroflowmetry scale the animation character will appear as soon as a 5 
ml/s flow rate is attained. If animation is disabled, the curve will be drawn without animation. 
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12 CALIBRATION 
12.1 CALIBRATE UROCAP™ USING UROSTYM® CHECKDB UTILITY 
If the UDS120 software is not installed on the computer, the Urocap™ transducer can be calibrated through the 
Urostym® CheckDB utility.  

1 Open the default calibration utility located in the C:\Program Files\Laborie Medical 
Technologies\Urostym®\Utilities folder. 

2 Run the CheckDB utility. 
3 Click the Connect to UDS button.  

 
 

4 Click the Uroflowmetry Transducer 
Calibration button. 

 

5 
 

Select the Urocap™ option and follow 
the instructions displayed at the bottom 
of the screen to complete calibration. 
 

Table 34: Check DB Utility – Calibrating the Urocap™ 
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To produce an even flow it is best to use a small hand held funnel. By keeping the water level constant 
in the funnel as you are pouring, the flow will be relatively constant. If you do not have access to a 
funnel, a paper or foam cup with a hole in the bottom will suffice. 

 

 

To verify your calibration, choose a Uroflow protocol, set zeroes, and pour using the same pouring 
procedure as the calibration. The unit should provide you with the same volume reading as during 
calibration. 

 

12.1.1 CALIBRATING EMG/MANOMETRY 
To calibrate channels 1, 2, and 3: 

1 1. Click Options > EMG/Manometry 
Calibration. 

 
 

2 From the resulting screen, you can calibrate 
the channels by following the on-screen 
instructions. 

To short the channel circuit: 
• For Channel 1 or 2: Connect the cable 

for surface electrodes into the channel 
you wish to calibrate. 

• Use the “shorting tool” provided with 
the unit and connect the leads from 
the shorting tool into the EMG 
headstage.  

Alternate methods: 
• Take the patient leads and hold the 

metal portion of the snaps down on an 
available metal surface like an I.V. 
pole. 

• Another method is to undo a 
paperclip, shape it into the letter “W” 
and place the top points of the letter 
“W” into the center holes of all three 
leads. 

• For Channel 3: have the transducer 
cable connected, with NO transducer 
in place. 

 

 
 

3 Once you are finished with calibration, click OK 
Table 35: Calibrating Urostym® Channels 
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13 TROUBLESHOOTING 
The following table explains common errors or problems, possible causes, and solutions. If these actions do not 
resolve the current situation, please contact Laborie at the number listed on the front inside cover of the manual. 

SYMPTOM(S) POSSIBLE CAUSE(S) CHECK/CORRECTIVE ACTION(S) 

No Power?  

or 

Stop/Reset Light OFF? 

 

Power cord unplugged • Check the power cord 
installation at both the 
Urostym® power entry module 
and the power outlet. 

• Plug the power cord into the 
outlet or power entry module. 

Power switch in the 
OFF position 

• Check to see if the power 
switch is in the ON position 

• Turn the power switch ON 

AC outlet not receiving 
voltage 

• Connect another appliance to 
the outlet to verify the voltage 

• Plug the power cord into 
another outlet 

Blown fuses  • Check the two fuses in the 
power entry module at the 
back of the Urostym® unit 

•  

 

• Replace blown fuses  

No Communication between the Urostym® 

and the PC? 

 

Communication cable 
unplugged 

• Check the Communication 
cable installation at both the 
PC Communication port and 
the Urostym® Communication 
port 

• Plug the Communication cable 
into the port 

Incorrect 
Communication port 
setting 

• Change the setting to the 
Communication port being 
used with the Set COM Port 
button 
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SYMPTOM(S) POSSIBLE CAUSE(S) CHECK/CORRECTIVE ACTION(S) 

Channel 1 does not respond.  Patient 
experiences no sensation with Channel 1 
yellow indicator LED illuminated? 

 

Poor patient contact 
due to excess hair, dry 
skin, adipose tissue  

• Check the patient contact with 
the probe or the surface 
electrodes 

• Ensure proper patient contact 
with the probe or the surface 
electrodes 

• Ensure Laborie lubricant 
(ULT050) is on probe 

Channel 1 cable not 
properly connected  

• Check all cable connections. 
Make sure cables are plugged 
in securely. 

Channel 1 cable 
defective 

• Connect Channel 2 cable into 
Channel 1 and check to see if 
Channel 1 is responding 

• Return the defective cable to 
Laborie Medical Technologies 
for repair 

Channel 2 does not respond.  No data/signal 

received from sensor with Channel 2 green 

blinking indicator LED illuminated? 

 

Poor patient contact 
due to excess hair, dry 
skin, adipose tissue 

• Check the patient contact with 
the surface electrodes 

• Ensure proper patient contact 
with the surface electrodes 

Channel 2 cable not 
connected properly 

• Check all cable connections 

• Make sure cables are plugged 
in securely. 

Channel 2 cable 
defective 

• Connect Channel 1 cable into 
Channel 2 and check to see if 
Channel 2 is responding 

• Return the defective cable to 
Laborie for repair 

Channel 3 does not respond.  No data/signal 

received from sensor with Channel 3 green 

blinking indicator LED illuminated? 

Poor positioning or 
inflation of probe 

• Check the patient contact with 
the Manometry probe; hold in 
place to prevent loss 

• Ensure proper patient contact 
with the Manometry probe at 
level with pelvic floor muscle 
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SYMPTOM(S) POSSIBLE CAUSE(S) CHECK/CORRECTIVE ACTION(S) 

 Manometry probe air 
leak 

• Inject 1 cc of air into the 
Manometry probe and dip the 
probe in a container of water. 
Look for bubbles in the water 

• Replace the Manometry probe 

Error message appears: 

 

UDS unit turned off  Turn on the UDS unit 

Error message appears: 

 

Incorrect characters 
used in current 
/envelope/template 
name 

Names for currents, envelopes, 
and/or templates cannot contain 
punctuation characters, such as 
commas or apostrophes, etc.... 

Probe disconnects from the system and 

stimulation stops 

Stimulation current 
greater than 10.5 mA 

For safety reasons, the software 
will not allow the stimulation 
current to go higher than 10.5 
mA. 

Table 36: Troubleshooting Instructions 
 

Note:  The Laborie Urostym is designed to be used as a stand-alone system, with the only mains power supply 
connection going through the Laborie medical-grade power supply (LIT). Do not connect it to any other devices 
unless the whole system is outside the patient environment or the other device is also using a medical grade 
power supply. 
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14   APPENDICIES 
  Specifications  

SYSTEM SPECIFICATIONS 
Upon request, LABORIE will make available any circuit diagrams, component part lists, and other technical 
documentation directly related to the Urostym®. 

Model Urostym® 

Dimensions 44cm (17”) x 25cm (9.8”)  x 9.3cm (3.6”) [L x W x H] 

Weight 1.7kg (3.8 lb.) 

Cable length  182cm (6’) 

Channels 3 (Input) 

Channel 1 – Stimulation/PMR 

Channel 2 – PMR 

Channel 3 – Manometry 

1 (Output) 

Channel 1 - Stimulation 

Sampling Rate Max. 20 pts/sec.  

Operating Conditions Temperature: +10°C to +40°C 

Humidity: 30% to 75% relative humidity (non-condensing) 

Pressure: 70 kPa to 106 kPa 

Transport and Storage Conditions Temperature: -29°C to +60°C 

Humidity: uncontrolled to 85% relative humidity 

Power Supply Input: 100-240 V~, 50-60Hz, 55W 

Fuse: 2X1A, 250V 
Pressure Transducer (TRA168) Cable Length: 4.0ft/1.2m 

Measurement Range: 0 to 200 cmH2O 

Tolerance: +/- 4% relative to reading or +/- 5 cmH2O, whichever is greater 

Line Isolation Transformer (LIT030, 
LIT055) 

LIT030 

Input: 120V~, 50/60Hz, 1000VA 

Output: 120V~, 50-60Hz, 1000VA 

LIT055 

Input: 230-240 V~, 50/60Hz, 1000VA 

Output: 230-240 V~, 50/60Hz, 1000VA 

Fuse Breaking capacity: 35A 

Voltage rating: 250Vac 

Current rating: 1A 
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Response time: Slow 

Series: MDL 

Table 37: Urostym Specifications 
INPUT CHANNELS 

Channel (1,2,3) Range Tolerance 
PMR 0-600 µV ±10% FS 
Manometry 0-250 cmH2O (0-184mmHg) ±10% FS 

Table 38: Input Channels – Range and Tolerance 
OUTPUT CHANNELS 

Channel (1) Range Tolerance 

Stimulation 
(Biphasic) 

Current 
 
 

0 – 25 mA (Rectal Probe) 
0 – 70 mA (Vaginal Probe/Surface 
Electrodes) 

(1) ±20 %FS 

Frequency 5 – 200 Hz +/- 10 % FS 
Pulse Width 200 – 500 μs +/- 5 % FS 

(1) The Urostym® is a current source device. Stimulation Output is calibrated at a nominal load of 500 ohms. Distortion might 
occur at low impedances as well as high impedances. 

Table 39: Output Channels – Range and Tolerance 

 

The values listed in the table below are the maximum values that the Urostym® unit will supply. 
Laborie Medical Technologies strongly recommends staying within the specified ranges. 

 

Calculations of the Maximum Power Density, Maximum Current Density and Maximum Charge per Pulse:   

*This is for the Anal probe 2.75 cm2, thus the maximum value for power and current maximum 25mA for this 
probe. 

** Is for the Vaginal probe 15.7 cm2  with maximum current 70mA for this probe.  

*** Is for the ELE625 patch electrodes 25 cm2  with maximum current 70mA for this patch.  

 

Maximum Power Density:  

P = power; F = frequency; θ = total length of pulse; U= volts;  I = current; R = resistance; U = IR  and *U = .025A x 
500Ω  and  **U/***U = .070A x 500 Ω 

 

For a periodic signal    Pmax = rms (U2 x F x θ) /R  using U= 12.5   R= 500Ω  θ = 1ms and  with F = 200Hz 

*Pmax = ( 12.52x 200x .001) / 500   

*Pmax =  31.25 / 500 = .063 Watts and .063W/2.75cm2 = .023 W/cm2 

And 

**Pmax = (352x 200x .001) / 500 

**Pmax = 0.49 Watts and 0.49W/ 15.7 cm2 = .031 W/ cm2  

***Pmax = (352x 200x .001) / 500 

***Pmax = 0.49 Watts and 0.49W/ 25.0 cm2 = .002 W/ cm2  
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Maximum Current Density  = Imax / Minimum electrode area 

                                                =  *25mA / 2.75 cm2 = 9.0mA/cm2 

                With                            = **70mA / 15.7cm2 = 4.5mA/ cm2 

= ***70mA / 25cm2 = 2.8mA/ cm2 

Maximum Charge per Pulse =  Imax x θ (total =1ms or ) 

                                                =  *25mA x . c =  .025A x .001 = 25 µC 

            With                            = **70mA x .0 = .070A x .001 =  70 µC 

= ***70mA x .0 = .070A x .001 =  70 µC 

Pmax as a function of impedance for the patch electrodes is calculated as  rms (U2 x F x θ) /R/S   using U= 12.5    θ 
= 1ms and  with F = 200Hz; S = 25 cm2 

***Pmax = (352x 200x .001) /25/ R = 9.8/R 

CLASSIFICATION 
MDD Directive 93/42/EEC Class IIa Equipment  

IEC-60601-1 Class I Equipment, Type BF Applied Parts  

FDA 510K Class II  

Canadian Medical Device 
Regulation 

Class II 

Degree of protection IPX0 Equipment: no protection against ingress of objects or water 

Mode of Operation Continuous 

Table 40: Urostym® 
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 Symbols and Labeling 

SYMBOLS 

 
Authorized Representative 

in the European Community 
(5.1.2)1: 

Indicates the manufacturer’s 
device representative in the 

European Community. 

 
SGS certification - certified 
to U.S. and Canadian safety 

standards. 

 
Date of Manufacture (5.1.3) 

1: 

Indicates the date of device 
manufacture. 

 
Manufacturer (5.1.1)1: 

Indicates the device 
manufacturer. 

 
Consult Instructions for Use 

(5.4.3)1: 

Manufacturer recommends 
consultation of Instructions 

for Use. 

 
Read Operator’s Manual 

(M002)4: 

Indicates user must refer to 
Owner’s/Operator’s 

Manual. 

 
Catalogue Number (5.1.6)1: 

Indicates the device model 
or catalogue number. 

 
Serial Number (5.1.7)1: 

Indicates unique device 
serial number for device 

traceability. 

 
Type BF Applied Part (Table 

D.1, 20) 2: 

Identifies a type BF applied 
part complying with IEC 

60601-1. 

 
Not for general waste. This 
product is designated for 
separate collection at an 
appropriate collection 

facility in accordance with 
WEE Directive. Dispose of 

in accordance to local 
regulations. 

 
Non-ionizing 

electromagnetic Radiation 
(5140) 5: 

Radio Frequency (RF) 
Transmitting Device 

Indicates presence of RF 
transmitters. 

 
Do Not Immerse 

 
Humidity Limitation (5.3.8) 1: 

Indicates the humidity range 
to which the medical device 

can be safely exposed. 

 
Temperature Limit (5.3.7) 1: 

Indicates the temperature 
limit to which the medical 

device can be safely exposed. 

 
Atmospheric Pressure 

Limitation (5.3.9) 1: 

Indicates the atmospheric 
pressure range to which the 

medical device can be 
safely exposed. 

 
System Safe Working Load 

 
Safety Label, Safe Working 

Load 2kg 

 
Safety Label, No Pushing 

(P017) 3: 

To prohibit pushing against 
a specified device. 

 
Importer (3725) 4: 

Indicates the entity that 
imports the medical device. 

 
GS1 DataMatrix for Unique 

Device Identification: 

(01) Global Trade Item 
Number 

(11) Date of Manufacture 

(21) Serial Number 

1. EN ISO 15223-1 Medical Devices – Symbols to be used with medical device, labels, labelling and information to be 
supplied – Part 1: General Requirements. 

2. CAN/CSA-C22.2 No. 60601-1:14 Medical electrical equipment – Part 1: General requirements for basic safety and 
essential performance. 

3. BS EN ISO:2012+A6:2016 Graphic symbols – Safety colours and safety signs – Registered safety signs (ISO 
7010:2011). 

4. ISO 7000:2014 – Graphic Symbols for Use on Equipment – Registered Symbols. 
5. IEC 60417 – Graphic Symbols for Use on Equipment. 

NOTE: Sterility symbols are applicable to consumbale devices only.  Refer to consumable device instructions for use for 
complete symbol and instructional overview. 

Table 41: Symbols Glossary 

https://en.wikipedia.org/wiki/File:WEEE_symbol_vectors.svg
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 Electromagnetic Compatibility (EMC) 

Standards to which conformity is declared: 

IEC 60601-1-2:2014 

(Ed.4) 

Medical electrical equipment – Part 1-2: General requirements for basic safety and essential 
performance – Collateral standard: Electromagnetic compatibility – Requirements and tests 

IEC 60601-2-10:2012  

IEC 60601-2-40:2016  

CISPR 11: 2010 Industrial, scientific and medical (ISM) radio-frequency equipment – Electromagnetic 
disturbance characteristics – Limits and methods of measurement 

CISPR 22: 2008 Information technology equipment – Radio disturbance characteristics – Limits and methods of 
measurement 

IEC 61000-3-2: 2009 Limits for harmonic current emissions (equipment input current =16 A per phase) 

IEC 61000-3-3: 2013 Limits – Limitation of voltage changes, voltage fluctuations and flicker in public low-voltage 
supply systems, for equipment with rated current =16 A per phase and not subject to 
conditional connection 

IEC 61000-4-2: 2008 Testing and measurement techniques –Electrostatic discharge immunity test 

IEC 61000-4-3: 2010 Testing and measurement techniques – Radiated, radio-frequency, electromagnetic field 
immunity test.  Ed 3.2. 

IEC 61000-4-4: 2012 Testing and measurement techniques – Electrical fast transient/burst immunity test 

IEC 61000-4-5: 2005 Testing and measurement techniques - Surge immunity test 

IEC 61000-4-6: 
2003+A1:2004+A2:2006 

Testing and Measurement Techniques – Immunity to Conducted Disturbances, Induced by 
Radio-Frequency Fields. 

IEC 61000-4-8: 2009 Testing and measurement techniques – Power frequency magnetic field immunity test 

IEC 61000-4-11: 2004 Testing and measurement techniques – Voltage dips, short interruptions and voltage variations 
immunity tests 

 
1. These limits are designed to provide reasonable protection against harmful electromagnetic or other 

interference in most installations. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful electromagnetic or other interference, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures: 

• Reorient or relocate the Urostym® 
• Increase the separation between Urostym® and affected equipment 
• Connect the non-medical system equipment into an outlet on a circuit different from that to which 

the Urostym® is connected. 
• Consult the dealer or experiences technical personnel for help. 
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Changes or modifications not expressly approved by LABORIE could void the 
user’s authority to operate the equipment. 

 
2. This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this 

device may not cause harmful interference and (2) this device must accept any interference received, including 
interference that may cause undesired operation.  
 

 

TABLES OF GUIDANCE AND DECLARATION REGARDING ELECTROMAGNETIC IMMUNITY 

 

• The use of accessories, transducers, and cables other than those specified by LABORIE may result in 
increased EMISSIONS or decreased IMMUNITY of the Urostym® 

• The Urostym® needs special precautions regarding EMC and needs to be installed and put into service 
according to the EMC information provided in this EMC section. 

• The following connectors have applied the ESD testing exemption: 
o None 

• Pins of connectors identified with the ESD warning symbol should not be touched and connections 
should not be made to these connectors unless ESD precautionary procedures are used. 

• Ensure ESD precautionary measures such as proper grounding, use of antistatic straps, use of antistatic 
sprays or solutions for wiping, and antistatic floor mats and table mats are in place. 

• It is strongly recommended that all staff involved receive an explanation of the ESD warning symbol and 
training in ESD precautionary procedures. 

• The minimum contents of an ESD precautionary procedure training should include: 
o An introduction to the physics of electrostatic charge. 
o The voltage levels that can occur in normal practice and the damage that can be done to 

electronic components if they are touched by an operator who is electrostatically charged. 
o An explanation should be given of methods to prevent build-up of electrostatic charge and 

how and why to discharge one’s body to earth or to the frame of the equipment or bond 
oneself by means of a wristband to the equipment or the earth prior to making a connection. 

• Portable and mobile RF communications equipment can affect the Urostym®. 

• This equipment/system is intended for use by health care professionals only. This equipment/system 
may cause radio interference or may disrupt the operation of nearby equipment. It may be necessary to 
take mitigation measures, such as reorienting or relocating the equipment or shielding the location. 

• The equipment should not be used adjacent to or stacked with other equipment. If adjacent or stacked 
use is necessary, the equipment should be observed to verify normal operation in the configuration in 
which it will be used. 
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IEC 60601-1-2: 2014 - TABLE 1 REQUIREMENTS 
Urostym® is intended for use in the electromagnetic environment specified below. The customer or the user of 
the Urostym® should assure that it is used in such an environment. 

Emissions Test  Compliance  Electromagnetic environment – guidance 
RF Emissions 
CISPR 11 

Group 1 The Urostym® uses RF energy only for its internal function. Therefore, its RF 
emissions are very low and are not likely to cause any interference in nearby 
electronic equipment. 

RF Emissions 
CISPR 11 

Class A  
The Urostym® is suitable for use in all establishments including domestic 
establishments and those directly connected to the public low-voltage 
power supply network that supplies buildings used for domestic purposes. 
 
Warning: This equipment/system is intended for use by health care 
professionals only. This equipment/ system may cause radio interference or 
may disrupt the operation of nearby equipment. It may be necessary to take 
mitigation measures, such as re- orienting or relocating the device or 
shielding the location. 
 

Harmonic Emissions 
IEC 61000-3-2 

Class A 

Voltage 
Fluctuations/Flicker 
Emissions  
IEC 61000-3-3  

Complies  
 

Table 42: Electronic Emissions 
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IEC 60601-1-2:2014 – TABLE 2 REQUIREMENTS 
The Urostym is intended for use in the electromagnetic environment specified below. The customer or the user 
of the Urostym should assure that it is used in such an environment. 

Immunity Test IEC 60601 Test Level Compliance Level Electromagnetic Environment - Guidance 
Electrostatic 
Discharge (ESD)  

IEC 61000-4-2 

±8 kV Contact 

±2kV, ±4kV, ±8 kV 
and ±15kV Air 

±8 kV Contact 

±15 kV Air 

Floors should be wood, concrete or ceramic tile. If 
floors are covered with synthetic material, the 
relative humidity should be at least 30%. 

Electrical Fast 
Transient/Burst  

IEC 61000-4-4 

±2 kV for power 
supply lines  

±2 kV for power 
supply lines 

Mains power quality should be that of a typical 
commercial or hospital environment. 

Surge 

IEC 61000-4-5 

±1 kV line(s) to line(s) 

±2 kV line(s) to earth 

±1 kV line(s) to line(s) 

±2 kV line(s) to earth 

Mains power quality should be that of a typical 
commercial or hospital environment. 

Voltage Dips, 
short interruptions 
and voltage 
variations on 
power supply 

input lines 

IEC 61000-4-11 

UT = 120/230 Vac 

0% UT 

(100 % dip in UT) for 
0,5 cycle at 0°, 45°, 
90°, 135°, 180°, 225°, 
270°, 315° 

70% UT 

(30% dip in UT) for 25 
cycles 

0% UT 

(100% dip in UT) for 5 
seconds 

<5% UT 

(>95 % dip in UT) for 
0,5 cycle 

40% UT 

(60% dip in UT) for 5 
cycles 

70% UT 

(30% dip in UT) for 25 
cycles 

<5% UT 

(>95% dip in UT) for 5 
sec 

Mains power quality should be that of a typical 
commercial or hospital environment. If the user of 
the equipment requires continued operation during 
power mains interruptions, it is recommended that 
the equipment be powered from an uninterruptible 
power supply or a battery. 

Power Frequency 
Magnetic Field 
(50/60 Hz) 

IEC 61000-4-8 

 

30 A/m 

 

30 A/m 

Power frequency magnetic fields should be at levels 
characteristic of a typical location in a typical 
commercial or hospital environment. 

NOTE UT is the a.c. mains voltage prior to application of the test level. 

Table 43: Electromagnetic Immunity 
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IEC 60601-1-2: 2014 – TABLE 4 REQUIREMENTS 
The Urostym® is intended for use in the electromagnetic environment specified below. The customer or the user 
of the Urostym® should assure that it is used in such an environment. 

Immunity Test IEC 60601 Test 
Level 

Compliance Level Electromagnetic Environment - Guidance 

Conducted RF IEC 
61000-4-6 
 

3 Vrms 
150 kHz to 80 
MHz 
6Vrms for ISM 
bands  

3 Vrms 
 

Portable and mobile RF communications equipment should 
be used no closer to any part of theUrostym including 
cables, than the recommended separation distance 
calculated from the equation applicable to the frequency of 
the transmitter. 
 
 
Recommended separation distance 
 
𝑑𝑑 = 1.17 �𝑝𝑝 150kHz to 80Hz 
𝑑𝑑 = 1.17 �𝑝𝑝 80 MHz to 800 MHz 

  
𝑑𝑑 = 2.3 �𝑝𝑝  800 MHz to 2.7 GHz 
 

Field strengths from fixed RF transmitters, as determined by an 
electromagnetic site surveya should be less than the compliance 
level in each frequency rangeb 

 
Interference may occur in the vicinity of known RF transmitting 
devices and equipment marked with the following symbol: 

 
 

 

Radiated RF  
IEC 61000-4-3  

3 V/m 
80 MHz to 2.5 
GHz 

3 V/m  

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection 
from structures, objects, and people. 

a) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile 
radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. 
To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be 
considered. If the measured field strength in the location in which the equipment is used exceeds the applicable RF 
compliance level above, the equipment should be observed to verify normal operation. If abnormal performance is 
observed, additional measures may be necessary, such as re-orienting or relocating the equipment. 

b) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 
Table 44: Electromagnetic Immunity – Radio Frequency Communications   
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IEC 60601-1-2: 2014 – TABLE 6 REQUIREMENTS 
Recommended separation distances between portable and mobile RF communications equipment and the 
Urostym®. 

The Urostym® is intended for use in an electromagnetic environment in which radiated RF disturbances are 
controlled. The customer or the user of the Urostym® can help prevent electromagnetic interference by 
maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and 
the Urostym® as recommended below, according to the maximum output power of the communications 
equipment. 

 
WARNING: Portable RF communications equipment (including peripherals such as antenna cables and external antennas) 
should be used no closer than 30 cm (12 inches) to any part of the Aquarius system, including cables specified by the 

manufacturer. Otherwise, degradation of the performance of this equipment could result. 
 

Rated maximum 
output power 
of transmitter 

(W) 

Separation distance according to frequency of transmitter 
 (m) 

150 kHz to 80 
MHz 

𝑑𝑑 = 1.17  �𝑝𝑝 
 

80 MHz to 800 
MHz 
 

𝑑𝑑 = 1.17  �𝑝𝑝 
 

800 MHz to 2.5 GHz 
𝑑𝑑 = 2.33  �𝑝𝑝 

 

0.01 0.12 0.12 0.23 
0.1 0.37 0.37 0.74 
1 1.17 1.17 2.33 

10 3.70 3.70 7.37 
100 11.70 11.70 23.30 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in metres (m) can be 
estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter 
in watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from 

structures, objects and people. 
Table 45: Separation Distances 
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 End User Software License Agreement 

Find licenses and terms for LABORIE products and services in the following locations: 

End User License Agreement: http://www.laborie.com/eula/ 

Terms and Conditions:  http://www.laborie.com/terms-and-conditions/ 

 Protocol Setup 

The following chart outlines the most common protocol setups: 

PROTOCOL NAME TYPE OF SESSION INTENDED FOR 

Evaluation of the  

Pelvic Musculature 

Pelvic Muscle Rehabilitation (PMR) 

Ch 1, EMG probe (adult use only) or 
perineal patches 

All patients (adult and pediatric) 

Can be used to evaluate muscle 
strength, coordination, and endurance 

Appropriate for anyone needing to 
regain pelvic floor muscle control 

Incontinence 

(start of treatment) 

PMR 

Channel 1, EMG probe (adult use only) or 
perineal patches 

Channel 2, abdominal patches 

All patients (adult and pediatric)  

Appropriate for anyone needing to 
regain pelvic floor muscle control 

Easy treatment for beginners 

Incontinence  

(end of treatment) 

PMR 

Channel 1,EMG probe (adult use only) or 
perineal patches 

Channel 2, abdominal  patches 

All patients (adult and pediatric) 

Appropriate for anyone needing to 
regain pelvic floor muscle control  

Challenging treatment 

Stress Incontinence Electrical stimulation  

Channel 1, EMG probe or perineal 
patches 

Frequency 50 Hz, band width 250µs  

Adult patients only 

Appropriate for stress urinary 
incontinence (targets fast twitch 
muscle fibers with high frequency 
current)  

Urge Incontinence Electrical stimulation 

Channel 1, EMG probe or perineal 
patches 

Frequency 20 Hz , band width 320µs 

Adult patients only 

Appropriate for urge urinary 
incontinence (targets slow twitch 
muscle fibers with low frequency 
current) 

Mixed Stim/Bio PMR and electrical stimulation 

Channel 1, EMG probe or perineal 
patches 

Frequency modulation 25Hz/75Hz, band 
width 500µs 

Adult patients only 

Used to treat stress, urge, or mixed 
incontinence, urgency and frequency 

Fluctuates between phases of 
stimulation and phases of PMR 

Targets slow and fast twitch muscle 
fibers by modulating between high 
and low frequencies 

http://www.laborie.com/eula/
http://www.laborie.com/terms-and-conditions/
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PROTOCOL NAME TYPE OF SESSION INTENDED FOR 

Mixed Urge/Stress Electrical stimulation 

Channel 1, EMG probe 

Frequency modulation 25Hz/75Hz, band 
width 500µs 

Adult patients only 

Used to treat stress, urge, or mixed 
incontinence, urgency and frequency 

Targets slow and fast twitch muscle 
fibers by modulating between high 
and low frequencies 

Uroflow2EMGS Uroflowmetry and EMG 

Channel 1, perineal patches 

Channel 2, abdominal patches 

Adult or pediatric patients with 
dysfunctional voiding patterns 

UroflowCh1EMG Uroflowmetry and EMG 

Channel 1, abdominal or  

perineal patches 

Adult or pediatric patients with 
dysfunctional voiding patterns 

UroflowVol Uroflowmetry Anyone needing Uroflowmetry testing 

PFR Pelvic Floor Rehabilitation. 

EMG and Manometry. 

Adult patients only. Used to treat urge 
urinary incontinence. Could be used to 
treat faecal incontinence and pelvic 
pain. It is often used with men as it is 
not possible to add the vaginal probe. 

Table 46: Protocol Setup 

PREDEFINED PROTOCOLS 
The following are predefined protocols stored in the Urostym® database.  These protocols CANNOT be deleted 
or modified, but they may be hidden. 

PROTOCOL NAME PROTOCOL DURATION (S) TREATMENT TYPE‡ 
Evaluation of the pelvic musculature 665 PMR 

Incont. (start of treatment) 1200 PMR 

Incont. (end of treatment) 1220 PMR 

Stress Incontinence. 1200 Stimulation 

Urge Incontinence. 1200 Stimulation 

Mixed Urge/Stress Incont. 1200 Stimulation 

Mixed Stim/Bio Treatment. 1254 StimBio 

Stress Urinary Incontinence 1360 StimBio 

Urge Urinary Incontinence 1360 StimBio 

Mixed Urinary Incontinence 1360 StimBio 

Pediatric 600 PMR 

Weakened Pelvic Floor Musculature 600 PMR 
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PROTOCOL NAME PROTOCOL DURATION (S) TREATMENT TYPE‡ 
Evaluation of the Pelvic Musculature 
(Manometry) 420 PMR 

Pelvic Pain 1800 Stimulation 

Urinary Retention 1080 Stimulation 

UroflowVol 1500 Uroflow 

Uroflowch1EMg 1500 Uroflow 

UroflowEMGs 1500 Uroflow 

Assessment EMG  200 PMR 

Assessment Manometry  200 PMR 

Beginner Incontinence Treatment  600 PMR 

Beginner Pediatric  600 PMR 

Evaluation of the Pelvic Musculature 
(Manometry) 420 PMR 

Evaluation of the pelvic musculature.  665 PMR 

Incont. (end of treatment)  1220 PMR 

Incont. (start of treatment)  1200 PMR 

Intermediate Pediatric  600 PMR 

Manometry, Incontinence End of Treatment  1220 PMR 

Manometry, Incontinence Start of Treatment  1200 PMR 

Mixed Stim/Bio Treatment.  1254 StimBio 

Mixed Urge/Stress Incont.  1200 Stim 

Mixed Urinary Incontinence 1360 StimBio 

Pediatric 600 PMR 

Pelvic Pain  1800 Stim 

Quick Flicks  300 PMR 

Stress Incontinence.  1200 Stim 

Stress Urinary Incontinence 1360 StimBio 

Urge Incontinence.  1200 Stim 

Urge Urinary Incontinence 1360 StimBio 
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PROTOCOL NAME PROTOCOL DURATION (S) TREATMENT TYPE‡ 
Urinary Retention  1080 Stim 

Uroflow2EMGS 1500 UroFlow 

UroflowCh1EMG 1500 UroFlow 

UroflowVol 1500 UroFlow 

Weakened Pelvic Floor Musculature 600 PMR 

PFR 400 PMR 

‡ Treatment Protocol Types:  
Stimulation: The Protocol is comprised of one or of several electrical stimulation Phases/ Sequences. 
PMR: The Protocol is comprised of one or of several PMR Phases/Sequences. 
Bio/Stim: The Protocol is comprised of one or of several stimulation and PMR Phase/Sequences. 
Uroflow: This is a Uroflowmetry Protocol and is comprised of one Phase/Sequence with or without EMG PMR 
capabilities. 
 

Table 47: Predefined Protocols 
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 Glossary 

14.1 TERMS USED IN URODYNAMIC TESTING 
Protocol: In the Urostym® software, a Protocol refers to a treatment session used to treat a specific pathology. 
Protocols placed in patient Sessions List consist of one, or several, stimulation and/or PMR Sequences and 
Phases. 

Phase: A Phase represents a group of actions (acquisition and/or stimulation), which unfold in a given time (Phase 
length). A Phase can be active (Work Phase) or passive (Rest Phase). A Work Phase can be one of action (such as 
an attempt to contract the pelvic floor) or relaxation (such as an attempt to relax the pelvic floor). 

PMR Terminology: 
• Average Contraction: Average value of the patient’s contraction 
• Effort: The percentage of time a patient is able to remain within the template goal line during a particular 

phase. 
• Max Contraction: Maximum value of the patient’s contraction 
• Template: PMR profiles that appear on the screen during the patient Session. The Template acts as a 

goal line or target area the patient must attempt to reach. 

Sequence: A Sequence represents a group of Phases that unfold in a sequential manner. 

Sequence Terminology: 
• Sequence No: The order of the Sequence in the Protocol 
• Repetition: How many times the particular Sequence will be repeated in the Protocol 
• Protocol Phase No: The order of the Phase in the Protocol 
• Sequence Phase No: The order of the Phase in the Sequence 
• Total Phase No: Total number of Phases in the Protocol 
• Work Time: Duration of the work Phase  
• Rest Time: Duration of the rest Phase (Note: During the Session, Rest Time will always appear as a 

countdown clock on the screen) 
• Channel No: The channel being used (channel 1, 2 or 3) 
• Channel Type: PMR (channels 1,2,and 3) or stimulation (channel 1) 

Stimulation Terminology: 
• Current: Current used in the electrical stimulation Session. 
• Envelope: Displays the way in which electrical stimulation will be administered  
• Frequency: Current frequency  
• Modulation: Current uses a modulated frequency (for example: current fluctuates between two 

predetermined frequencies) 
• Pulse Width: Current pulse width, sometimes referred to as bandwidth 
• Plateau Value: Maximum current intensity in a stimulation envelope  
• Ramp Up Time: In a stimulation Envelope, time allocated for the current to ramp up (in seconds) to the 

Plateau value 
• Plateau Time: In a stimulation Envelope, time allocated for current remaining at maximum intensity 

(plateau period) 
• Ramp Down Time: In a stimulation Envelope, time allocated for current to ramp down to 0 
• Rest Time: In a stimulation Envelope, time allocated for resting (no current) within the Phase 

Uroflowmetry Terminology: 
• Flow: urine flow rate in ml/sec 
• Volume: Voided volume (in ml) 
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• Uroflow Lag Time: Time from the start of pelvic floor relaxation to the start of flow (in seconds) 

14.2 COMMON ACRONYMS 
• ALPP: Abdominal leak point pressure 

• BOOI:  Bladder outlet obstruction index i 

• BCI: Bladder contractility index 

• BPH: Benign prostate hyperplasia 

• BVE:  bladder voiding efficiency 

• CLP:  Cough leak point pressure  

• CMG:  Cystometrogram  

• DLPP:  Detrusor leak point pressure  

• DSD:  Detrusor sphincter dyssynergia  

• EMG:  Electromyogram  

• FUL:  Functional urethral profile length  

• ICS:  International Continence Society  

• IH2O:  Rate of fluid infusion during  

• ISD:  Intrinsic sphincter dysfunction (or 
deficiency) 

• IUD: Intrauterine device 

• LinPURR: linear passive urethral resistance 
(Nomogram available in UDS120 software) 

• LPP:  Leak point pressure  

• LUTS:  Lower urinary tract symptoms  

• MCC:  Maximum cystometric capacity  

• MUCP:  Maximum urethral closure pressure  

• MUP:  Maximum urethral pressure  

• NGB:  Neurogenic bladder Pabd Abdominal 
pressure 

• Pabd: Abdominal pressure 

• Pclo:  Closure pressure  

• Pdet:  Detrusor (or subtracted) pressure   

• Pura:  Urethral pressure  

• Pves:  Intravesical pressure  

• PVR:  Post-void residual  

• SUI:  Stress urinary incontinence  

• UDC:  Uninhibited detrusor contraction  

• UPP:  Urethral pressure profile  

• URA:  Urethral resistance factor - Nomogram  

• UTI: Urinary tract infection 

• VH2O:  Volume infused during CMG  

• VLPP:  Valsalva leak point pressure  

• VS:  Valsalva  

• VUR:  Vesico-ureteral reflux 
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ANNEX: PATIENT CARE GUIDE 

1 INTRODUCTION TO URINARY INCONTINENCE 
About thirteen million Americans, 38% of females and 19% of males, are plagued by urinary incontinence. Studies 
show prevalence ranges from 1.5% to 5% in the male population ages 15-64, and 10% to 30% in women of the 
same age. 

 Although such a large proportion of the population experiences urinary incontinence, the majority of those 
individuals do not seek care. Due to the sensitive nature and social stigma associated with this disorder, patients 
are often embarrassed to discuss the condition with their physician. Surveys have indicated that less than half of 
the community-dwelling population with incontinence seeks treatment for their symptoms. As the Agency for 
Health Care Policy and Research (AHCPR), now the Agency for Healthcare Research and Quality, guidelines for 
urinary incontinence suggest, prevalence of incontinence does increase with age, but should not be considered a 
normal part of aging. 

Although studies show women are unaware of the current treatments for incontinence or assume treatment is 
ineffective, the AHCPR guidelines suggest that treatment of urinary incontinence is effective in most people - 
around 80 per cent of urinary incontinence can be cured completely. Urinary incontinence is a symptom rather 
than a disease. It may be related to any of the following conditions: 

• Pregnancy or childbirth  
• Birth defects 
• Pelvic surgery 
• Injury to the pelvic region or spinal cord 
• Neurological diseases 
• Multiple sclerosis 
• Polio infection 
• Degenerative changes associated with 

ageing 
• Pelvic Organ Prolapse (POP) 
• Constipation 
• Other bowel symptoms  
• Chronic cough (from smoking, chronic 

bronchitis or asthma) 
 

• Hormonal changes 
• Drugs 
• Recurrent Urine Tract Infection (UTI) 
• Childhood bedwetting 
• Some types of prostate surgery  
• Stroke, Parkinson's disease  
• Urinary retention  
• Diabetes  
• Persistent straining to empty the bladder 

or bowel with or without constipation  
• Persistent heavy lifting  
• Lack of regular exercise 

 

 

1.1  TYPES OF INCONTINENCE 
There are different types of urinary incontinence: 

Stress urinary incontinence (SUI): consists of urine leakage with increased intra-abdominal pressure. Increased 
pressure in the abdominal cavity pushes down on the bladder. When pressure in the bladder exceeds urethral 
pressure, urine is lost unless the bladder outlet is adequately closed to prevent leakage. Increases in intra-
abdominal pressure may occur with laughing, coughing, or sneezing, or during physical exertion such as bending, 
lifting, or exercise. Although urine loss is typically small, the amount of leakage depends on the degree of exertion 
along with the severity of the pelvic floor weakness. With strenuous activities such as exercise or heavy lifting, urine 
loss may be large enough to soak the outer clothes.  

Although pelvic floor weakness is more common during pregnancy, after childbirth and after the age of 40, SUI 
can happen to women of any age. One in three women experience SUI at some point in their lives. 

Causes that contribute to the weakening of the pelvic floor: 
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• Pregnancy: carrying the increasing baby weight in the pelvis over 40 weeks puts extra stress on the 
pelvic floor. Also, during pregnancy the hormone relaxin softens the muscles of the pelvic floor to ready 
the pelvis for birth. Around 50% of post-partum women suffer from SUI.  

 

• Childbirth: with vaginal delivery, it is possible the nerves of the pelvic floor become stretched and 
bruised. After delivery, this contributes to the pelvic floor work improperly and the muscles may not 

respond as well. A Danish study (http://www.vaginalweights.org/urinary_stress_incontinence.html) of 
more than 2000 women found those who had a tear or episiotomy had a three-fold risk of developing 
urinary incontinence.  

 

• Obesity: this means there is increased pressure on abdominal muscles, which in turn puts increased 
pressure on the pelvic floor. A British study by Dallosso et al in 2002 (Dallosso et al: Dallosso, HM, 
McGrother, CW, Matthews, RJ, & Donaldson, MMK. The association of diet and other lifestyle factors 
with overactive bladder and stress incontinence: a longitudinal study in women. BJU International 2003 
92 (1), 69.) found that women who were overweight were nearly twice as likely to have SUI as someone 
of normal weight. (A BMI of 20-25 is normal weight; 26-30 is overweight; 30+ is obese.) 

 

• Hysterectomy: may cause damage to the pelvic floor. There is now a resulting change in the supporting 
ligaments along with a change in pelvic contents. Hormonal changes also contribute to a weakening 
of pelvic floor muscles. 

 

• Smoking: having a chronic cough puts pressure on the pelvic floor and makes SUI worse.  Chronic 
coughers have a low success rate in PFT. 

 

• Chronic Cough: places repeated pressure upon the pelvic floor muscles.  Chronic coughers have a 
low success rate in PFT. 

 

• Menopause: after menopause estrogen levels are lower, which may mean muscle pressure around the 
urethra is weaker and leaks are more likely to occur. The urethra may be less elastic and less able to 
close completely. Postmenopausal women are also more likely to be overweight and have had a 
hysterectomy. 

 

• Medication: some types of medication can affect the pelvic floor. Examples are alpha-blockers used 
to treat high blood pressure, some antidepressants and sedatives, and some muscle-relaxant drugs.  

 

Things that can damage the sphincter muscle: 

• A pelvic fracture 
• Bladder neck surgery 
• Radical prostatectomy (for men) 

 

Urge urinary incontinence (UUI): also known as overactive bladder (OAB) or detrusor overactivity is defined as the 
involuntary loss of urine associated with a strong desire to void. When bladder fullness is perceived, an individual 
senses a sudden urge to urinate and is unable to delay voiding. Urine loss is typically moderate to large and often 
occurs on the way to the bathroom. An involuntary contraction of the bladder detrusor muscle occurs prematurely 
during filling and forces urine through the urethra. An individual with urge incontinence is unable to inhibit this 
contraction or close the urethra adequately and urine leakage results..  

People with UUI may also: 

• Need to empty the bladder more frequently than normal (more than eight times a day) 
• Void smaller volumes 
• Get up in the night several times to pass urine 
• Feel the bladder does not empty completely 
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• Leak when hearing running water.  
 
Often, voiding frequency is increased in an effort to keep the bladder empty and avoid the sudden urge to urinate. 
Urge incontinence predominately occurs in older adults.  

Mixed urinary incontinence (MUI): is a combination of stress urinary incontinence and urge urinary incontinence 
and occurs in 40% of incontinent people. 

Overflow urinary incontinence (OUI) usually happens when there is a blockage (such as a narrowing in the urethra), 
so the bladder does not empty completely. When the bladder refills, it puts pressure on the obstruction, which 
gives way slightly and results in a small leak of urine. Overflow urinary incontinence is less common in women than 
SUI.  

Functional Incontinence: Urinary leakage associated with impairment of cognitive or physical functioning, 
psychological unwillingness or environmental barriers to the toilet. Example: Elderly with impaired mobility and 
distant toilet. 

1.2 EFFECTS OF EXERCISE 
The AHCPR advocates the selection of the least invasive treatment with the fewest potential adverse effects as a 
first course of treatment of urinary incontinence.  For many types of urinary incontinence, behavioral techniques 
meet these criteria. Suggested behavioral techniques include toilet assistance, bladder retraining, timed voiding, 
diet and fluid management, positive affirmations and pelvic muscle exercise with or without augmentation by 
PMR, electric stimulation, or vaginal weight training. Behavioral techniques are most effective with motivated 
patients who wish to avoid medication, surgical intervention, or the need for protective garments. Inquiries of 
medical practices using pelvic floor therapy report a 75 to 80% success rate. 

Pelvic muscle exercises began in 1948 when Dr Arnold Kegel developed a program of progressive pelvic floor 
contractions in combination with PMR training to treat women with urinary incontinence. Various researchers over 
the past 50 years have implemented their own exercise protocols, but the exercise itself has remained the same. 
The goal of pelvic muscle exercise is to isolate and strengthen the pelvic floor, or levator ani musculature. Often 
patients do not know how to squeeze the pelvic floor appropriately without also using nearby muscles or 
accessory muscles. 

2 PELVIC FLOOR ANATOMY & FUNCTION 
The pelvic floor muscles are a group of muscles that attach to the base of the bony pelvis, including the levator 
ani musculature. They provide support to the pelvic organs and control of the outlets. Quality of support depends 
on anatomical position, resting tone, volume or cross-sectional area of musculature, and integrity of the fascia. 

The pelvic floor is composed of two types of muscle fibers: 30% fast-twitch and 70% slow-twitch fibers. At rest, 
slow-twitch fibers are activated through toning to provide support to pelvic viscera. These fibers are primarily 
responsible for setting the resting tone. Pelvic floor muscle tone may vary with hormonal status such as during 
menstrual cycle, pregnancy, and menopause and can be influenced by the lumbar and pelvic musculoskeletal 
system. Resting tone may be classified as hypotonic, normal, or hypertonic. Typically, persons experiencing 
incontinence have hypotonic or underactive muscle tone, which indicates insufficient functional activity of the 
pelvic floor muscles.  Of note is the fact that children are often treated for the opposite (hypertonic) muscles. 

Fast-twitch fibers are activated during increases in intra-abdominal pressure in an effort to quickly close the 
urethra and provide greater resistance in anticipation of increased pressure from the bladder. With contraction, 
the urethra, vagina, and rectum are compressed and pelvic organ displacement is prevented. Contracting the 
pelvic floor enhances closure of the urethra. With this closure, pressure in the urethra is elevated and leakage is 
avoided. Contraction also helps maintain urethral position during increases in intra-abdominal pressure. When 
patients perform a contraction prior to activities that raise intra-abdominal pressure, stress incontinence can be 
avoided. Pelvic floor contraction also reflexively inhibits the detrusor muscle, which lessens or represses the 
incidence of urge incontinent episodes. 
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3 TREATMENT OF INCONTINENCE 
3.1 PMR 
PMR uses a device that records electromyographic (EMG) information of the pelvic floor utilizing either surface 
electrodes or a vaginal or rectal probe. PMR teaches the patient how to improve control of the external sphincter 
by contracting the pelvic floor muscles. Visual and auditory stimuli such as graphs, color, and sound provide 
information (feedback) regarding the patient’s performance. The feedback shows the patient what alteration is 
needed, thereby increasing their awareness. A trained clinician continually monitors performance and provides 
verbal cues to enhance or alter performance. With increased awareness of performance, the patient is 
encouraged to make small changes in order to increase motor control of the pelvic floor muscles. PMR training is 
most appropriate for those who are cognitively intact with neurologically intact musculature and motivated to 
comply with the program.  
 

The PMR instrument displays the electrical signals of the pelvic floor muscles in a graphic form with optional color 
and auditory capabilities. A system with two or more channels is preferable in order to monitor the activity of 
potential compensatory muscle groups such as the abdominals or gluteals.  

The EMG graph displays data such as resting tone, strength and endurance.   

• Resting tone is the amount of tension/ tone that resides in the musculature when the muscle is inactive.   
A strong muscle has more tone than a weak muscle at rest. 

• Strength is recorded by the maximum pressure or the peak of the waveform.  
• Endurance is the average muscle contraction measured across the waveform. Endurance can be 

measured by the period of time a contraction is sustained or the maximum number of repetitions that can 
be performed.  

 

Temporal characteristics include contractibility or rate of the rise of the contraction and time to release.  

The EMG signal of the second channel monitors the accessory muscle activity and should remain quiet with little 
activity. 

PMR provides visual and/or auditory stimuli to facilitate motor learning. With a visual image of muscle activity on 
the display and verbal cueing, the patient is assisted in identifying a correct pelvic floor contraction. Once the 
contraction is isolated consistently, an individualized exercise program is developed. The therapist utilizes basic 
exercise and motor learning principles to facilitate neuromuscular re-education. 

Principles used in general strength training can be applied to pelvic muscle exercise. The principles include 
specificity of training, overload, and reversibility. Training effects are highly specific to the methods employed; 
therefore, an exercise program should include training of both fast-twitch and slow-twitch muscle fibers. Fast-
twitch fibers are trained with quick burst-like contractions interspersed with relaxation, while slow-twitch fibers are 
targeted with less intense endurance contractions of longer duration. Overload principles suggest a muscle must 
be continually worked beyond its normal limit to gain strength. An exercise program must be continually 
modified in order to account for improvements in strength and endurance. The principle of reversibility applies to 
the muscle’s ability to return to its prior level of function with cessation of exercise.  

Patients must continue the prescribed program in order to maintain the desired effect.  

Principles of motor learning are helpful when re-educating the pelvic floor muscles. When instructed to contract 
the pelvic floor, many individuals also recruit the abdominal, gluteal, or thigh muscles. As the skill acquisition 
proceeds, the individual is able to free accessory muscles and perform a more fine-tuned movement with less 
effort. 

During an initial PMR training session, the focus is to increase the patient’s awareness of pelvic muscle activity and 
inhibition of accessory muscle use. The patient practices the skill while utilizing visual information and verbal 
cueing from the therapist. Verbal cueing decreases as proficiency of the task increases. PMR training provides 
constant awareness of performance via visual and verbal feedback; therefore, acquisition of the skill is 
accelerated. 
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3.2 ELECTRICAL STIMULATION 
If the patient is having difficulty with voluntary contraction or isolation of the pelvic muscles as seen in muscle 
wasting or weakness, electrical stimulation may be an appropriate adjunct to training.  With urge suppression 
training the resultant pelvic floor contraction serves to inhibit the detrusor.  

Electrical stimulation provides contraction of the pelvic muscles with an external device. The patient may also be 
instructed to squeeze as the stimulator elicits contraction of the pelvic muscles thus creating an active rather than 
passive exercise. Repeated contractions heighten a patient’s awareness of contractility and increase strength and 
recruitment. Electrical stimulation aids in the identification of the pelvic floor musculature and thus increases 
awareness of the muscles to target with the exercises. 

3.3 INDIVIDUAL TREATMENT 
Exercise prescription for pelvic muscle exercises should be individually tailored for the patient. Once the patient 
has demonstrated the ability to isolate pelvic floor contraction in the supine position, training may progress to the 
seated and standing positions. Each successive position provides additional gravitational demands on the pelvic 
muscles. These include variables such as body weight; active muscle recruitment to maintain posture; fascial and 
ligamentous support; and pelvic organ position. The training program must also address the specific functional 
needs of the patient. If leakage occurs when lifting a patient’s 10-pound infant, training should simulate this 
activity. The therapist is limited only by his or her own creativity when it comes to functional training. 

3.4 BEHAVIOR MODIFICATION 
No matter how productive a training session may seem, if the patient is not compliant with their home exercise 
program, no improvement in muscle strength, coordination, or symptoms will result. It is the therapist’s 
responsibility to collaborate with the patient to develop an exercise program that fosters adherence. The 
therapist determines the appropriate exercise parameters, but should consider the context of the patient such as 
work schedule, familial duties, community responsibilities, etc. Establishing specific exercise times such as during 
daily commutes to and from work, and at lunch break may be easier to integrate, rather than instructing your new 
patient to exercise their pelvic floor five times per day for the rest of their life. If the patient is an active part of the 
process, they will be more likely to be compliant.  Ask what works best for them and their schedules. 

PMR serves as an effective training tool that provides patients with the knowledge and skills to successfully 
exercise the pelvic muscles and manage their urinary incontinence symptoms. Medical management of this 
disorder is limited by the incontinent patient’s hesitancy to seek care. Guidelines have been established by the 
AHCPR in an attempt to educate health care providers and advance the timely diagnosis and treatment of urinary 
incontinence. It is our responsibility as health care professionals to increase public awareness in order to 
encourage individuals to seek treatment and reduce the psychosocial and economic costs of this manageable 
disorder. 

3.5 TARGET POPULATION 
The target population for pelvic floor rehabilitation is extensive — both men and women of all ages may benefit 
from this form of treatment. Some of the dysfunctions that can be treated include: 

• stress urinary incontinence  
• urge urinary incontinence  
• mixed urinary incontinence  

Children who have the cognitive ability to listen to and follow instructions may benefit from pelvic floor therapy as 
well. 

Those who respond best to pelvic floor re-education/rehabilitation (PFR) include: 

• Patients who are motivated to comply with the program, are cognitively intact, and are capable of following 
instructions. 

• Patients who have a pelvic floor that is neurologically intact. 
• Patients who suffer from urge incontinence. 
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• Patients who experience mild stress incontinence - including men with post-prostatectomy incontinence 
(PPI) after a suitable period of healing. 

• Patients who suffer from mixed incontinence (combination of urge and stress incontinence). 
• Patients who do not want medication or surgery. 
• Patients in pre-natal training.  
• Patients in pre-prostatectomy training. 

Some use PFR while waiting for surgery or as a psychological bridge to surgery by allowing them to feel they have 
exhausted all possible options. 

AVOID: 

• Patients who want a quick fix with little effort. 
• Patients who do not have the time. 
• Patients with cognitive impairment. 

3.6 DESIGNING A TREATMENT PLAN 
Pelvic floor strengthening may have two phases:  

i. A PMR phase and an electrical stimulation phase or 
ii. A PMR phase only (if they are able to isolate their muscles and simply need strengthening practice.  

3.6.1 PMR PHASE 
PMR is a technique employed to improve pelvic floor strength by learning to control/contract the proper muscle 
groups through increased awareness. A computer monitor is used to visualize these contractions. An EMG or 
pressure Manometry probe is used (vaginally or anally) along with surface patch electrodes (abdominally). The 
patient is asked to squeeze the probe while keeping abdominal muscles relaxed. 

CONTRAINDICATED FOR PATIENTS WHO: 
• Have symptomatic UTI, fever 
• Have fecal impactions 
• Are too feeble, senile 
• Have heavy menses 

 

 

DO NOT USE the probes if the patient’s anatomy would make proper probe insertion difficult or 
impossible 

 

 

DO NOT USE the probes if the patient has an infection of the bladder, vagina, rectum, or anus; or 
displays the symptoms of infection (such as itching, painful urination, sores, or fever). 

 

3.6.2 STIMULATION PHASE 
Stimulation is a technique by which current is used to stimulate or inhibit (as seen in urinary retention or pelvic 
pain therapy) the pelvic floor muscles. This is done through the EMG probe or through special surface patch 
electrodes. Stimulation is to occur within a comfort zone for the patients who are asked to report when they feel a 
tingling/tugging sensation. 

CONTRAINDICATED FOR PATIENTS WHO: 
• Have symptomatic UTI, fever 
• Have fecal impactions 
• Are too feeble, senile 
• Have heavy menses 
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• Have a pacemaker (patient should seek expert medical opinion before treatment) 
• Metal IUD’s 
• Have rectal bleeding/swollen hemorrhoids (if using an anal probe) 
• Have cardiac arrhythmia 
• Had pelvic surgery in the last 6 months without primary surgeon’s permission 
• Have metal prosthetics in pelvic area (i.e., Hip implants) 
• Have seizure disorders 
• Have a pessary that contains metal. The pessary can be removed prior to start of session and replaced 

when session is complete. 
• Have cancer in the pelvic region (colorectal or genitourinary cancer) 
• Pregnancy or suspected pregnancy 

 

 

DO NOT USE the probes if the patient’s anatomy would make proper probe insertion difficult or 
impossible 

 

 

DO NOT USE the probes if the patient has an infection of the bladder, vagina, rectum, or anus; or 
displays the symptoms of infection (such as itching, painful urination, sores, or fever). 

 

4 PATIENT EDUCATION 
4.1 PRIOR TO TESTING 

• The first visit takes about one hour, and subsequent visits will last 30-45 minutes. 
• Recommended clothing:  

o Men, children: long T-shirts, loose, easy-to-remove bottom clothing  
o Women: loose dress or loose, easy-to-remove bottom clothing 

• The goal of pelvic muscle training is to isolate the pelvic floor muscle, specifically the levator ani. 
• A Pelvic Floor Strengthening session lasts approximately 30 minutes and is repeated once a week for 4 to 

8 weeks, lasting typically for 6 weeks.  
• Patients must perform daily pelvic floor exercises at home in between each session.  Give them 

homework and have them report on their homework when they return.  Use the voiding diaries to note 
improvement during the course of treatment.  Recommend daily bowel movements to aid in the ease of 
pelvic floor exercise.  

• It may take 3 to 4 weeks to notice changes in symptoms. Improvement may be noticed to continue for up 
to 6 months following a course of PFR with continued home Pelvic Floor Exercises (PFE’s).  It is not 
uncommon to return for a ‘tune up’ session or two sometime later. 

• Discontinuing home exercises will result in a return of urinary symptoms 
• If electrical stimulation is used, it will not be painful 

4.2 PATIENT POSITIONING 
1. Electrical stimulation provided by probes requires supine or side-lying in order to hold the probe in proper 

alignment with the pelvic floor muscles. The gynecology chair or the exam table offer ease in positioning. 

2. Consider comfort: Lounger chair, couch, bean bags for kids, video chair for kids, etc. 

3. Ease of viewing: patients need to be able to see the video screen easily and without glare from lighting. 

4. Consider anatomical limitations: prolapse, handicaps, etc. 

5. Standing, laying, sitting are all possible positions for PMR exercises.  Consider the diagnosis and treat 
accordingly: stress with lifting requires they lift during therapy while using Knack technique to prevent 
leaking. 
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4.3 SESSION ROOM SETUP 
• Room Environment: Dim the lights: overhead fluorescent lighting places glare on the screen.  Dim, 

indirect lighting is relaxing. 
• Privacy: Keep a “Do Not Disturb” sign on the door to indicate privacy. 
• Music: Load the computer’s music library with tunes appropriate for the patient population.  Adults may 

enjoy and prefer meditation music while children may prefer their own music. 
• Props: A rubber ball (soft to be held between the knees); elastic bands to exercise hip abductors and 

adductors; foot stool for comfortable seating while voiding; free standing toilet paper holder and trash 
receptacle; books and articles to promote self-care and interest; artwork for the wall appropriate for your 
clients; changing area that has clothes hooks and a mirror; a bell to call nurse when micturition complete, 
and so on. 

4.4 PATIENT HOMEWORK 
Everyone should have homework assignments.  A means of keeping track of the daily assignments is best as  this 
provides the basis for lifestyle modification.  Patients are in charge of their bladder and this includes daily exercise 
sets for improved muscle tone, endurance, and strength. 

• Go easy in the beginning.  Encourage them to go easy in the beginning, just as in any new endeavor, as 
this is ultimately about progress. 

• Base assignments on their abilities during the PMR session.  They may need to practice lying down if they 
are obese, or have prolapse without the aid of a pessary.  Eventually, follow with sitting and finally 
standing.  However, if the patient is suffering from SUI then standing, walking, or jumping would be the 
better choice for practice.  Consider the age, abilities, and reason for PMR. 

• Bowel Management must be stressed.  The most helpful approach to pelvic floor rehabilitation includes 
a daily bowel movement.  Constipation must be treated and avoided.  Please note: Pelvic floor 
rehabilitation often treats fecal incontinence as the pelvic floor muscle includes the rectal sphincter as 
well. 

4.4.1 HOMEWORK EXAMPLES 
• For weak muscles perform these exercises three times a day: 

o 5 quick contractions, then a  20 second relax (repeat 5-7 times)  
o 5 second hold for endurance followed by a 10 second rest (repeat 5 - 7times) 

• For strong muscles perform these exercises three times a day: 
o 5 quick contractions, then a 20 second relax (repeat 8-10 times)  
o 5 second hold for endurance followed by 10 second rest (repeat 8-10 times)   

• No increasing of the target during the first week;  
• Drink recommended volume of water (8 ounces 6-8 times a day)  
• Eat plenty of fresh fruit, vegetables and cereals to avoid constipation. 
• If you experience urgency that makes you rush to the toilet, drink less caffeine (tea, coffee and cola) and 

drink more water. 
• Regular exercise - walk as much as possible. 
• Wear clothes that are easy to manage. 
• If you have to get up more than once during the night to pass urine (nocturia) then it is advisable not to 

drink any fluid within three hours of going to bed. 
• Involve your family in understanding the problems so that embarrassment is not so much of a problem. 
• Get someone else to do heavy lifting and avoid strenuous exertion in general. 
• Drinking alcohol is likely to worsen any type of urinary incontinence because it is a diuretic and stimulates 

the kidneys to produce more urine. 
• Bowel management – stress the importance of maintaining a 3 or 4 on Bristol Stool Scale  

4.5 EFFECTS OF FLUIDS 
• Large fluid intake: if you drink more than 1500ml a day, it will likely worsen SUI because the volume of 

the bladder increases and puts more pressure on the pelvic floor. It also will worsen UUI because you 
pass smaller amounts of urine more frequently. 

http://www.netdoctor.co.uk/diseases/facts/constipation.htm
http://www.netdoctor.co.uk/health_advice/facts/nocturia.htm
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• Not enough fluids: cutting down too much will make your urine more concentrated, which irritates your 
bladder and worsens UUI. It also decreases the effective capacity of your bladder.  

• Caffeinated drinks: caffeine is a diuretic, which means it makes your kidneys make more urine, so you 
pass more water. Caffeine also irritates the detrusor (bladder) muscle. Tea, coffee, cola and chocolate all 
contain caffeine.  

• Carbonated drinks: if you drink carbonated drinks daily, you’re more likely to have SUI and UUI. This is 
possibly because the most popular carbonated drinks are colas, which contain caffeine and citric acid.  

• Alcohol: alcohol is a diuretic and makes your kidneys to produce more urine, which will worsen urinary 
incontinence.  

4.6 PREVENTING URINARY INFECTIONS 
• Urinate after bathing or after sexual intercourse. 
• Drink plenty of fluids in order to keep the urine light in color and to wash any germs out of the bladder. 
• Empty the bladder every 3 to 4 hours during the day. Holding back urination causes normal bacteria to 

multiply. 
• For females, correct wiping is from front to back; especially after a bowel movement.  
• For females, stay away from bubble baths as this is often irritating to the genital area by removing the 

normally protective secretions for the urethra. Avoid the use of soap in the genital area until reaching 
puberty – this means washing the genital area with warm water. 
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5 EQUIPMENT OVERVIEW 
5.1 SURFACE ELECTRODES AND PRESSURE PROBES 
*Indicates item not for use with pediatric patients 

Probes Non-Sterile, Single Patient Use 

PRODUCT Description 

Channel 1 Cable Stimulation/PMR*  

(part number CAB 896) 

 

Length: 10ft.   

Used in Adult Pelvic Floor Therapy when a probe is employed for both EMG 
and/or stimulation. 

Channel 2 Cable EMG  

(part number CAB906) 

 

Length: 10ft.   

EMG headstage labeled for Channel 2 but may also be used on Channel 1 in 
Pediatrics and for Adults who do not use a probe for stimulation/PMR. 

Vaginal Probe Classic* 

(part number PRB450) 

 

Length: 4inches/10cm.   

Reusable for individual patient.  Useful for both PMR and Electrical 
Stimulation.  Vaginal probe will deliver up to 70mAmp of Stimulation. 

Anal Probe* 

(part number PRB055) 

 

Length: 3.25inches/8.3cm.  

 Slender. Reusable for individual patient.  Useful for both for PMR and 
Electrical Stimulation.  The anal probe is set to deliver up to a max of 25mAmp 
of Stimulation. 

Vaginal Atrophic Probe* 

(part number PRB085) 

 

Length: 3 inches/ 8cm.  

Slender Vaginal probe. Useful for both PMR and Electrical Stimulation. 
Capable of stimulation to a max of 70mAmp.  For use with vaginal atrophy. 

Vaginal Tampon Probe* 

(part number PRB425) 

 

Length: 2inches/5cm.  

Short Vaginal probe.  Useful for both PMR and Electrical Stimulation. Capable 
of stimulation to a max 70vAmp. 

EMG surface electrodes – 3/pack pre-
wired 

Surface electrodes that offer excellent transmission of EMG activity in a soft 
patch with superior adhesive qualities.  Useful for PMR only. The ability to 
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PRODUCT Description 

(part number ELE428) 

 

dispose of the patch with the wire leads after each use ensures optimal 
hygiene. Recommended for both pediatric and adult PMR sessions. 

Surface Electrodes / stimulation – 
reusable 4/pack  

(part number ELE625) 

 

Dual purpose patches useful for PMR and capable of stimulation.  Reusable on 
the same patient.  Used for pelvic or abdominal accessory muscles. After use 
store on enclosed plastic film.  Lifetime depends on care and storage.  

Package of 3 Surface Electrodes  

(part number ELE425) 

 

Useful for PMR. Recommended for abdominal or accessory muscle 
measurement, used with EMG leads, ELE350 

EMG Leads Red and Green (reusable)  

(part number ELE350) 

 

 

Length: 10inches. 

 For use with ELE 425 for PMR.  Life expectancy with cleaning between uses is 
approximately 6 months to 1 year.  Two sets are recommended.   

Beaker   

(part number DIS173) 

 

Plastic with measurements embossed onto the clear surface.  For 
Uroflowmetry 
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For Manometry * 

NOTE: for PMR only – no stimulation 

PRODUCT Description 

Channel 3 Manometry Cable  

(part number TRA168) 

 

Length: 4.0ft. /1.2m   

Connects to Urostym® Channel 3. 

Pressure transducer cartridge + Luer 
Lock Plug DIS130 

 

Used for recording direct muscle pressure. Connects to pressure tubing. 

 

Vaginal Manometry Probe  

(part number PRB113) 

 

Length: 4.25 inches (11cm).  

Used for monitoring direct muscle pressure with TRA168. 

Latex free, micro-porous, supple, air filled probe.  Air is inserted / removed 
with a 10cc syringe.  Lubricate before insertion. 

Vaginal Pressure Tubing  

(part number PRB080) 

 

Length: 30 inches / 77cm.  

Used with TRA168  for direct muscle pressure measurement 

 

Requires 10cc syringe to inflate with 5cc of air.  For use with Vaginal 
Manometry Probe only. 

Anal Manometry Probe  

(part number PRB108) 

 

Length: 2.25inches/ 6cm.  

Used for recording direct muscle pressure. 

Latex free, supple, micro-porous, air filled probe.  Lubricate before insertion. 

Anal Pressure Tubing  

(part number PRB078) 

 

Length: 48 inches / 122cm.  

Pressure tubing for use with anal Manometry probe only. 

Annex, Table 1: Surface Electrodes and Pressure Probes 
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5.2 UROSTYM® CONNECTION DIAGRAMS FOR ADULT PATIENTS 
Channel 1 Connection: Stimulation and Electrical PMR 

​Manometry           PMR               Bio/Stim
Ch3                        Ch2                      Ch1

 

​

Anus VaginaPelvic Floor

​

OR

VAGINA

ANUS

PROBE

URETHRA

BLADDER

PELVIC FLOOR MUSCLES

BLADDER

URETHRA

ANUS

PROBE

RECTUM

Patient’s 
Thigh Third 

Electrode on 
Bony 

Prominence

Electrodes at 10 
o’clock and 3 o’clock 

Position

Anal 
Sphincter

 
 

 ​Anal
EMG/Stimulation 

Probe 
PRB055

 
 
​

Vaginal
EMG/Stimulation Probe

PRB450

 
 

Surface electrode 
ELE625

​

Ch1 cable
CAB896

(For internal probe PMR and/or Stimulation)​

 
 

​Ch2 cable
CAB906

(For surface PMR and/or Stimulation; the cable is 
plugged into the Ch1 connector instead of 

Ch1 Cable)

 

Annex, Figure 1: Channel 1 Connection - Stimulation and Electrical PMR 
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Channel 2 Connections: Electrical PMR 

​Manometry           PMR               Bio/Stim
Ch3                        Ch2                      Ch1

 

Abdomen

Touchoroof Pre-wired 
Patch Electrode

ELE428

Surface Electrode 
ELE625

EMG Lead Set – ELE350

Patch Electrode 

Abdomen Abdomen

 

Annex, Figure 2: Channel 2 Connections - Electrical PMR 
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Channel 3 Connections: Manometry PMR 

​Manometry           PMR               Bio/Stim
Ch3                        Ch2                      Ch1

 

Anus

BLADDER

URETHRA

ANUS

PROBE

RECTUM

Vagina

VAGINA

ANUS

PROBE

URETHRA

BLADDER

PELVIC FLOOR 
MUSCLES

Anal Connecting Tube, 
PRB078

Anal Manometry Probe, 
PRB108

Vaginal Connecting Tube, 
PRB080

Vaginal Manometry 
Probe, PRB113

Ch3 cable
Pressure Transducer TRA168

 

Annex, Figure 3: Channel 3 Connections - Manometry PMR 
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5.3 PROBE AND SURFACE ELECTRODE PLACEMENT 
5.3.1 SURFACE ELECTRODES 
EMG values will vary according to: tissue impedance, electrode placement, contact medium and grounding. 

5.3.2 VAGINAL/ANAL EMG PROBES 
Graphic values will vary according to: intra-cavity electrolyte balance, probe placement and contact medium.  
Please use conductive lubricant such as ultrasound gel. 

Pelvic floor (connects to channel 1 of the Urostym® unit) 

• Two surface electrodes are placed on the peri-anally, at the 10 o’clock and 2 or 3 o’clock positions.  
The third electrode is placed on a bony prominence (knee or hip bone) or fleshy inner thigh. 

Product Patient Setup 

PF: ELE425 electrodes 

 

 

 

PF: ELE428 electrodes 

 

 

 

 

PF: ELE625 electrodes   
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PF: PRB450, or  PRB085 or PRB425 

 

or 

 

or 

 

 

PF: PRB055 

 

 

Annex, Table 2: EMG Probe Setup 

 

Annex, Figure 4: Probe Insertion - Female 
Note:  

• The metal rings are in line with the pelvic floor muscles. 
• It is necessary to hold the probe in place to maintain positioning. 
• Maximum setting of 70 mAmp.  

BLADDER 

URETHRA 

PROBE 

VAGINA 

ANUS 

PELVIC FLOOR MUSCLES 
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Annex, Figure 5: Probe Insertion - Male 
Note:  
• Anal probe placement for men or women.  
• Maximum stimulation = 25mA, rectal tissue is more sensitive 
• Hold the probe in alignment with pelvic floor muscle. 

 

If probe use is contraindicated, Laborie’s 50mm X 50mm surface electrode patches (ELE625) may be used to 
provide electrical stimulation. Smaller patches must NEVER be used for stimulation. 

5.3.3 VAGINAL/ANAL MANOMETRY PROBES 
Manometry is defined as providing a true measure of pelvic floor strength, Manometry may be performed with an 
anal probe on males, and a vaginal probe on females.  The anal probe may be employed in the female with 
atrophic vaginitis and other anatomical limitations. 

Product Patient Setup 

PF: PRB113 

 

 

 

PF:PRB108 

 

 

Annex, Table 3: Manometry Probe Setup 
1. Position patient in side-lying or other comfortable position for insertion. 
2. Take each cartridge out of its package, and remove the protective covers from the back and from the 

connector ends. 

BLADDER 

URETHRA 

PROBE 

ANUS 

RECTUM 
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3. Gently squeeze both sides of the cartridge and slide it over the TRA168 transducer until it clicks into 
place. 

 

Annex, Figure 6: Transducer Setup 
4. Attach pressure tubing, with an attached stopcock, to the lower (male) end of the cartridge. 

 

Annex, Figure 7: Pressure Tubing and Transducer Setup 
5. Connect the pressure tubing to the corresponding Vaginal/Anal Manometry Probe. 
 

                         OR  
Annex, Figure 8: Probe and Pressure Tubing Setup 

 

6. Spread a light coating of lubricating gel on the probe to ease insertion. 
7. Carefully insert the lubricated probe. 
8. Use a syringe to inflate the probe with 3 cc’s of air for vaginal probe. The anal probe requires 

1cc of air. Confirm it is not too hard or too soft. 

 
Annex, Figure 9: Inflate Probe 

9. Hold the probe in position during therapy. 
NOTE:  Do not move the cartridge during tests; movement of the cartridge may affect readings. 

10. After use, clean the probe with soap and water and store dry. 

CARTRIDGE 

LUER LOCK PLUG 

TRA168 
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Abdomen 
• Apply two surface electrodes to the right or left abdomen, near the level of the hip.  Apply the third, 

ground electrode, to the hip bone region or on the inner fleshy thigh. 
Abd: ELE425 electrodes 

 

 

 

Abd: ELE428 electrodes 

 

 
 
 

 

Abd: ELE625 electrodes 

 

 

 

Annex, Table 4: EMG Setup 
5.4 BEGINNING THE PELVIC FLOOR STRENGTHENING PROGRAM 

• Document any failed treatment (such as Kegel exercises for 6 weeks) before starting PMR. 
• Review and document patient symptoms during each session. 
• Assign pelvic floor home exercises to be performed 2-3 times daily: repetitions and relaxations for long 

squeezes and short squeezes based upon the individual’s demonstrated ability during each therapy 
session. 

• Patients are typically placed in a semi-reclined position or on their side. The probe is inserted (by clinician 
or patient) using an ultrasound gel. Note: standard water-soluble lubricants are not adequate and should 
not be used.  The probe is inserted properly when the "curve" or narrowing in the probe is at the point of 



LABORIE Urostym® Owner’s Manual UST-UM07      -        Patient Care Guide 127 

exiting the body.  ** ALWAYS verify probe positioning before starting stimulation. Starting the stimulation 
when the probe is not inserted properly may be painful. 

• If you are unable to use a probe with a particular patient, surface patch electrodes may be used perianally 
instead.  These may be patients who refuse the probe or have severe Prolapse.  In this case, the ELE625 
surface electrodes are better for this population. 

5.5 SELECTING PROTOCOLS BASED ON DIAGNOSIS 
5.5.1 STRESS URINARY INCONTINENCE  

Protocol Name Stimulation PMR 

Incont. (start of treatment)   Y 

Incont. (end of treatment)   Y 

Stress Incontinence.  Y  

Mixed Urge/Stress Incont.  Y  

Mixed Stim/Bio Treatment.  Y Y 

Mixed Urinary Incontinence Y Y 

Stress Urinary Incontinence Y Y 

Weakened Pelvic Floor Musculature  Y 

Manometry, Incontinence Start of Treatment  Y 

Manometry, Incontinence End of Treatment  Y 

Quick Flicks  Y 

Annex, Table 5: Stress Urinary Incontinence Protocols 
5.5.2 URGE URINARY INCONTINENCE  

Protocol Name Stimulation PMR 

Incont. (start of treatment)   Y 

Incont. (end of treatment)   Y 

Mixed Urge/Stress Incont.  Y  

Mixed Stim/Bio Treatment.  Y Y 

Mixed Urinary Incontinence Y Y 

Weakened Pelvic Floor Musculature  Y 

Urge Incontinence.  Y  

Urge Urinary Incontinence Y Y 

Manometry, Incontinence Start of Treatment  Y 

Manometry, Incontinence End of Treatment  Y 

Annex, Table 6: Urge Urinary Incontinence Protocols 
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5.5.3 MIXED URINARY INCONTINENCE  
Protocol Name Stimulation PMR 

Incont. (start of treatment)   Y 

Incont. (end of treatment)   Y 

Mixed Urge/Stress Incont.  Y  

Mixed Stim/Bio Treatment.  Y Y 

Mixed Urinary Incontinence Y Y 

Weakened Pelvic Floor Musculature  Y 

Urge Incontinence.  Y  

Urge Urinary Incontinence Y Y 

Manometry, Incontinence Start of Treatment  Y 

Manometry, Incontinence End of Treatment  Y 

Quick Flicks  Y 

Annex, Table 7: Mixed Urinary Incontinence Protocols 
5.5.4 URINARY RETENTION 

Protocol Name Stimulation PMR 

Urinary Retention Y  

Pediatric  Y 

Beginner Pediatric  Y 

Intermediate Pediatric  Y 

Uroflow2EMGS (a diagnostic tool useful for 
treating Urinary Retention) 

 Y 

Annex, Table 8: Urinary Retention Protocols 
5.5.5 PELVIC PAIN 

Protocol Name Stimulation PMR 

Pelvic Pain  Y  

Pediatric  Y 

Beginner Pediatric  Y 

Intermediate Pediatric  Y 

Annex, Table: Pelvic Pain Protocols 

5.5.6 FECAL INCONTINENCE 
Protocol Name Stimulation PMR 

Incont. (start of treatment)   Y 

Incont. (end of treatment)   Y 
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Stress Incontinence.  Y  

Mixed Urge/Stress Incont.  Y  

Mixed Stim/Bio Treatment.  Y Y 

Mixed Urinary Incontinence Y Y 

Stress Urinary Incontinence Y Y 

Weakened Pelvic Floor Musculature  Y 

Urge Incontinence.  Y  

Urge Urinary Incontinence Y Y 

Manometry, Incontinence Start of Treatment  Y 

Manometry, Incontinence End of Treatment  Y 

Annex, Table 9: Fecal Incontinence Protocols 
5.5.7 CONSTIPATION 

Protocol Name Stimulation PMR 

Mixed Urge/Stress Incont.  Y  

Mixed Stim/Bio Treatment.  Y Y 

Mixed Urinary Incontinence Y Y 

Urge Urinary Incontinence Y Y 

Pediatric  Y 

Beginner Pediatric  Y 

Intermediate Pediatric  Y 

Annex, Table 10: Constipation Protocols 

5.6 HOW TO MEASURE SUCCESS 
1. Transformation from wet to dry, or from depressed to empowered, requires a comprehensive approach: 

mental, physical, spiritual and emotional.  
2. Routine, consistent use of voiding / bladder diaries. 
3. Diet and fluid intake guidance and handouts for home use and completion; use to measure success over 

time. 
4. Quality of Life (QOL) assessment which takes into account the amount and number of ‘accidents’ per day.  

This assessment is used with each visit to chart success. 
5. Notice the amount of effort needed to complete the selected protocol.  Over time effort will be less as tone 

and strength improve — indicating the need for a more challenging protocol. 
6. Note when fatigue starts while performing the protocol.  Is it at the beginning, middle or the end of the 

protocol?  Fatigue is measured by increasing use of accessory muscles, for instance squeezing gluteal and/or 
abdominal muscles, or holding their breath to complete a phase or to reach the goal. 

7. Note the patient’s change of positioning during ‘effort’/ work.  Do they start to employ accessory 
muscles to aid in their success?  Have they started to hold their breath to succeed?   See Fatigue 
section below. 

8. As with any muscle-building endeavor, make it easy and not impossible in the beginning to allow for success, 
which rewards a patient’s efforts.  They will want to return and they will do their homework, too! Not really a 
measurement of success but a key to achieving success! 

9. Review their homework chart with every visit.  Encourage and praise their efforts. 
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5.7 FATIGUE 
Consider ending therapy sessions when the patient shows signs of fatigue. Muscle Fatigue may be noted in one 
or all of the following ways:   
• When the ability to hold the long contraction starts to diminish. 
• When the ability to perform quick flicks of equal heights starts to fall. 
• When use of accessory muscles (abdominal and/or gluteal) increases. 
 

5.8 PEDIATRIC PELVIC FLOOR THERAPY 
Dysfunctional elimination syndrome (DES) denotes an abnormal pattern of elimination for the child 
characterized by urinary and bowel incontinence and withholding. ii (along with history of UTIs). The child’s efforts 
to stay dry or to avoid voiding results in high muscle tone, and limited voidings (which eventually results in 
incontinence)  

The cause is not well defined but may include delayed developmental control, effects of environmental/ social 
factors, UTI and learned behavior.  There is controversy over the use of disposable diapers and delayed toilet 
training.  Here culture and education play their roles. 

The main goal is to restore a normal micturition pattern, reduce or relax pelvic floor activity, eliminate 
incontinence, UTI, and constipation.  DES management requires a combination of cognitive, behavioral and 
physical approaches.  The support and encouragement of the family members is built into the combination of 
approaches. 

 
5.8.1 STEPS TO INITIATING THERAPY WITH CHILDREN 
Items needed: 

• Two sets of surface electrodes for the pelvic floor and the abdomen. 
• Empty beaker placed on the Uroflow transducer. 
• Bladder ultrasound probe, ultrasound gel, tissues for cleaning ‘jelly belly’. 
• Step stool for short legs while seated on the commode chair. 
• A toilet seat insert for smaller children. 
• Two minute timer to ‘slow down time for voiding’. 
• Softer rubber balls: four-inch and six-inch diameter balls. 
• Toilet paper and receptacle. 
• Privacy screen/ curtain. 
• Rewards basket to pick from at completion of study. 
• Cups for water (should they come with an empty bladder). 
• Protocol selected for sessions: Uroflow / 2 EMG, beginner pediatric. 
• Voiding, stool, fluid and diet charts. 
• Give or display a copy of the Bristol stool chart (example on page - 136 -) and fiber foods list. 
• Instructions on obtaining a voiding history. 
• Instruction on PMR homework and voiding practices for home. 
• School excuse for appointments. 
• Instructions for school nurse / teacher to allow for timed voidings in school. 
• Alarm or watch choices, for example Potty MD™. 
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5.8.2 BASIC APPROACH 
Keeping mindful of the fear associated with visits to the doctor, have a set of electrodes available to ‘show and 
tell’, and to place on and off a doll or their own arm.  If there is an initial visit planned without treatment sessions, 
send a set of electrodes home with the parents to position on their child’s ‘bottom’ as will be performed in the 
actual session.  This is also the time to instruct on the routine needed for the start of all sessions: 

• The younger children are invited to bring their favorite stuffed animal as a guest. 
• Provide a selection from a rewards basket for cooperation at session’s end. 
• Make it fun and enjoyable.  There has been much stress for these children related to voiding and overall 

behavior. 
• Remind parents to have the child arrive with a full bladder. 
• If siblings must come, they and the parents may enjoy time together in the waiting area. 

 

5.8.3 FIRST SESSION  
If time and the child allows (with their full bladder), you may take a pre-voiding measurement of the bladder 
volume using a bladder scanner or ultrasound probe.  Take this opportunity to apply the surface electrodes to the 
peri-anal region.  Apply to the pelvic floor region and not onto the gluteal region.  Apply the second set of 
electrodes to the lower abdomen.  The ground is placed on a hip bone or inner thigh for both sets of electrodes. 

When ready to void: 

• Select the Uroflow/2EMG protocol.   
• Perform the adjustment screen (scaling for relaxed and max contraction) for each channel.   
• Set the volume and flow selections appropriate for the child’s age.   
• Once screens are completed, it is time for the child to sit on the commode chair and void.    
• Position the screen for their viewing.  

You may wish to select the audible icon for either channel 1 or 2.  The audible selected is dependent upon the 
child’s EMG picture.  Are the channel 1 muscles employed more than channel 2 or is it the opposite?   If you note 
high use of the abdomen to ‘push’ during voiding, channel 2 could be chosen to highlight the need to ‘calm’ this 
area during voiding.  Should the pelvic floor muscles be overactive, creating the saw-tooth or intermittent voiding 
picture, highlight channel 1 as audible to aid in relaxation emphasis and to create the ‘bell curve’. 

If they have a “shy bladder” at this time, start a PMR session while they are positioned on the commode chair and 
provide a cup of water for drinking as well. 

There is no rule for the order of protocols.  The goal is to address their voiding picture by increasing awareness of 
muscle use.   Awareness of the need for relaxation is key to improved voiding, including providing relaxation 
techniques such as deep breathing using the 2 minute timer. PMR sessions are selected to heighten their 
awareness with emphasis on relaxation.  Here the goal is to increase the time at toileting. Often these children 
take less time than needed to void thus leaving the toilet when not completely empty. 
 
Note the voiding position as well as a girl’s wiping practice.  Note the color and aroma of urine. 

Perform a post-void residual (PVR) measurement immediately after voiding.  It may be necessary to ask the child 
to void again based upon this measurement.  This is called ‘double voiding’. 

Please note PVR measurements in the Comments section of the Uroflow report.  You may wish to give the child a 
record of the voiding graphic in order to work toward improvement. 
 
Second and Subsequent Sessions 

The child and family are now aware of the ‘game plan’.  They bring in diet, fluid, voiding and stool records.  
Rewards are visible with stars or stickers on their charts.   
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Uroflowmetry is first, otherwise start with the assessment and/or PMR sessions appropriate for the child. If they 
have high ‘relaxation’ (tone) or difficulty relaxing, use the protocols which allow for success in both relaxation and 
contractions. If they have “giggle incontinence”, for example, use the protocols that emphasize quick 
contractions.  

Giggle Incontinence, defined as urine lost when laughing or with stress efforts, requires a quick flick protocol 
which emphasizes the quick squeeze muscles.  Combine this with instructions for home on the Knack technique: 
squeeze before laughter and any other stress related effort.  They must employ the quick squeeze muscles in 
their homework, too. 

Review the voiding curve and the contraction / relaxation picture with them.  Ask them what is their practice when 
voiding at home and school.  Do they take enough time? Enlighten them to the change that is required for 
greater and greater improvement. 

Check a PVR after the voiding.  Compare to previous PVR measurements.  Is there improvement?  Go on to the 
PMR sessions next.  Keep in mind their attention span and employ the video games near the end of the sessions. 

5.8.4 PMR SESSIONS 
Is there a recommended position for PMR?  With children, the most important emphasis is on their comfort and 
building their confidence with the visit, so they may sit or stand.  Much depends on the diagnosis and on their 
ability to perform in the position of their choosing.  Use this time to experiment with the position that allows for 
the most relaxed outcome.  Have them help you to find this optimal position.  You will note the easiest position 
for relaxation is seated.  And boys are encouraged to sit to void during these sessions in order to aid in their 
relaxation efforts. 

Since seated is usually the optimal position, employ props such as a rubber ball to aid in identification of the 
pelvic floor.  This allows them to squeeze the ball between their knees for contraction and to release the ball for 
relaxation.  Props are helpful initially to aid in identification.  Another recommendation is to ask them to squeeze 
as if holding back ‘gas’. 

5.8.5 HOW MANY SESSIONS? 
The number of sessions and the spacing between sessions is determined by both the patient’s progress (or lack 
thereof) and the clinician’s evaluation of parent support / understanding for home practice.  There is no firm 
recommended number of sessions as each child and their situation varies.   

Generally speaking, 5 to 8 sessions are the common amount needed; however, some will only need to see the 
voiding picture once and they understand it while others may need more time. Consider stressors at home and 
school should you note a regression during sessions. 

The overall picture of progress – be it slow or fast – can be seen by factors such as: improved relaxation during 
Uroflowmetry or PMR sessions, improving (decreasing) PVR, and decreasing incidence of UTI’s. 

5.8.6 WHEN IS GRADUATION? 
This requires a multifaceted review of behaviors and outcomes.   

• You will note improved (decreasing) PVRs 
• Improved understanding and relaxation during voiding.   
• There is a decrease or elimination of UTIs.   
• There are no reports of leakage  
• Timed voiding is now a daily practice at school and at home.   
• Fluid intake has improved  
• Increased fiber intake.   
• There may also be a report of improvement in the night time record of dryness as well! 
• Bowel management is appropriate. 
 

Should the need for a ‘tune-up’ visit occur at some later time; this is ok.   
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5.8.7 UROFLOWMETRY 
Uroflowmetry is a non-invasive screening tool used as an indicator of lower urinary tract function that measures 
the flow rate and volume over time. Combining Uroflowmetry with the measurement of post void residual (PVR) 
urine is useful in the evaluation of bladder outlet obstruction and voiding dysfunction. 

Uroflowmetry combined with EMG monitoring of the pelvic floor and abdominal muscles provides a clear portrait 
of both pelvic and abdominal muscle involvement during voiding.   

Accurate Uroflowmetry requires a voiding volume of at least 60 cc in pediatrics and 150cc in adults (but <600 
cc).  Interpretation includes a description of the flow pattern.  Normal flow pattern is a smooth, bell shaped curve.  
Age, sex and volume affect the flow rate.  Spikes and /or quick fluctuations may be the result of muscle straining, 
contracting or even beaker movement.  The EMG picture aids in determining the influence of muscles upon voiding. 

Dysfunctional (immature) voiding is common in children; however, there are also cases of dysfunctional voiding in 
adults with and without obstructional etiology.  Use of EMG monitoring with the Uroflow is highly recommended 
for the complete picture. 

For the evaluation of Uroflowmetry, the International Continence Society has recommended the following 
definitions from Abrams, Blaivas, Stanton, & Andefson, 1988 iii: 

• Voided volume: Total volume of urine expelled from the bladder. 
• Flow time: The time over which measurable flow actually occurs. 
• Residual urine volume (PVR): The total volume of urine remaining in the bladder after voiding. 
• Maximum Flow Rate (Qmax) The maximum measured value of the flow rate in ml/sec. 
• Time to maximum flow: The elapsed lime from the onset of flow to the point of maximum flow 
• Continuous urinary flow: A constant urinary stream without interruptions. 
• Mean flow rate (Qmean): Volume voided divided by flow time. The average flow rate is only interpretable 

if flow is continuous without aberrancy, either at the initiation or termination of voiding. 
• Flow pattern: Subjective description of the regularity of voiding. The flow pattern must be described 

when the flow time and average flow rate are measured 
• Intermittent flow: Flow pattern in which interruptions of varying duration occur between episodes of 

voiding. 

The average flow rates vary depending on age and sex iv: 

 Males Females 

Ages 4 – 7 10 mL/sec. 10 mL/sec. 

Ages 8 - 13 12 mL/sec 15 mL/sec 

Ages 14 – 45 21 mL/sec 18 mL/sec 

Ages 46 – 65 12 mL/sec 15 mL/sec 

Ages 66 – 80 9 mL/sec 10 mL/sec 

Annex, Table 11: Flow Rates 
Normal values for Uroflowmetry v 

Males 

 

< 40 years old   >22 ml/sec 

40-60 years old >19 ml/sec 

>60 years old    >13 ml/sec 

Females 

 

<50 years old    >25 

>50 years old    > 18 

Annex, Table 12: Normal Values 
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5.9 DEFINITIONS USEFUL WITH PELVIC FLOOR MUSCLE REHABILITATION (PFR) 
Anal Sphincter: Two rings of muscles, internal and external, surrounding the rectum and anus which helps to 
control passage of bowel movements. 

Anus: Muscular opening at the end of the rectum and is the outlet for solid waste. 

Behavioral Therapy:  Treatment that uses conditioning and awareness to change behavior.  This may be done 
with PMR, bladder training, electrical stimulation, habit training, pelvic muscle exercises and prompted voidings. 

Benign Prostatic Hyperplasia (BPH): Condition characterized by the benign growth of the prostate, often 
resulting in voiding difficulties due to the obstruction.  Also known as benign prostatic hypertrophy. 

Bladder:  Muscular organ located in the pelvis for temporary storage of urine. 

Bladder Training: Exercises that focus on changing urinary habits and patterns.  A person is encouraged to hold 
(resist or inhibit urgency to void) urine for increasingly longer periods of time, until the comfortable voiding 
interval is increased.  This technique is used in the treatment of urge incontinence, interstitial cystitis, and 
frequency. 

Colon:  Lower portion of large intestine leading to the rectum. 

Conservative Approach or Treatment: Any non-surgical technique to treat incontinence. 

Constipation: Hard, dry, firm bowel movements that are difficult to pass and less frequent than twice a week; 
may contribute to voiding difficulties. 

Cystocele:  Bulging of the bladder into the anterior vaginal wall. 

Diuretic:  Any drug, food or beverage that promotes increased urine excretion. 

Electrical Stimulation:  Application of an electrical current to stimulate a muscle contraction.  It also serves to 
help identify muscles to those lacking in sensation.  This is accomplished with vaginal or rectal probes or surface 
electrodes. 

Encopresis:  Uncontrolled bowel movements or smears of feces into underwear or inappropriate places by an 
individual over the age of four.    

Enuresis: Involuntary loss of urine; during sleep termed ‘nocturnal’. 

Episiotomy:  Surgical incision into the perineum between the vagina and anus to ease childbirth through the 
vagina. 

Estrogen: Hormone contributing to female sexual characteristics, produced in the female ovaries and male 
testicles, in adrenal glands and fat. 

Fecal Impaction:  A hard mass of stool packed in the rectum rather than passing through normally.  Impaction 
can contribute to incontinence. 

Fecal Incontinence:  Accidental and involuntary loss of liquid or solid stool or gas from the anus. 

Frequency:  Voiding more than 8 times in a twenty-four hour period. 

Functional Incontinence: Physical disability or mental confusion leading to inability to void in appropriate places 

Hormone: Chemical substances made in endocrine glands and essential for human biological processes. 

Hysterectomy: Surgical removal of the uterus 

Incontinence:  Loss of urine. 

Kegel Exercises:  Pelvic muscle exercise to decrease or eliminate incontinence. 
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Mixed Urinary Incontinence:  A combination of urge and stress incontinence. 

Overflow Incontinence:  Temporary inability to void, followed by uncontrollable urine flow, associated with over 
distension of the bladder. 

Pelvic Diaphragm : The levator ani muscle group. 

Pelvic Muscles:  General term referring to the muscles of the pelvic diaphragm and urogenital diaphragm as one 
unit, sometimes referred to as the pelvic floor muscles. 

Pelvic Muscle Exercises (PMEs): Repetitive exercises of the Pubococcygeal muscles also referred to as Kegel or 
pelvic floor exercises. 

Pelvic Muscle Weights:  Small weights placed in the vagina to offer resistance for the muscles to contract 
against. 

Perineum/Perineal Muscles:  Area of muscle and tissue between the vagina or scrotum and anus. 

Pessaries:  Devices for women placed intravaginally to treat pelvic relaxation or prolapse of pelvic organs. 

PMR: A technique in which a person learns to consciously control involuntary responses such as heart rate, brain 
waves, and muscle contractions, by having these responses electronically monitored and noted through sound, 
graphs, or on a screen.  In terms of pelvic floor rehabilitation, computerized equipment is used to monitor and 
record progress. 

Prostate:  Firm, muscular gland that surrounds the urethra in males. 

Prostatectomy:  Removal of all or part of the prostate gland. 

Prostatitis: Infection of the prostate; acute or chronic. 

Rectocele:  A bulging of the rectum into the posterior vaginal wall. 

Rectum:  Final several inches of the intestines below the colon and above the anus. 

Reflex Incontinence:    Loss of urine due to hyperactivity of the bladder muscle and/or involuntary urethral 
relaxation in the absence of the sensation associated with the desire to urinate.  This occurs in neurogenic 
disorders. 

Scheduled Toileting:  Fixed schedule of voiding; for example, every 2 to 4 hours.  Also known as timed voiding 
or prompted voiding. 

Sphincter:  Circular muscle that tightens and relaxes to control the flow of urine from the urethra.  There are 
internal and external urethral and anal sphincters. 

Stress Incontinence:  Loss of small amounts of urine with increased intra-abdominal pressure during coughing, 
sneezing, laughing, jumping and running. 

Urethra:  Tube connecting the bladder to the outside for the passage of urine. 

Urge Incontinence:  Sudden leaking of relatively large amounts of urine when the bladder muscle contracts, 
overcoming the contractions of the pelvic muscles. 

Urinary Retention:  Inability to empty the bladder, which may lead to bladder and kidney damage. 

Urinary Tract Infection (UTI):  Inflammation of the Urinary tract. 

Uterine Prolapse:  Descent of the uterus into the vaginal canal. 

Valsalva Maneuver:   The action of closing the airway and straining down on the abdominal muscles (such as 
straining during bowel movements). 
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5.10 BRISTOL STOOL CHART vi 

 

Reprinted courtesy of Lewis,  SJ, and  Heaton, KW. University Dept. of Medicine, Bristol Royal Infirmary, UK. 

 
Annex, Table 13: Bristol Stool Chart 

 

 

 

 

http://www.ncbi.nlm.nih.gov/sites/entrez?Db=pubmed&Cmd=Search&Term=%22Lewis%20SJ%22%5BAuthor%5D&itool=EntrezSystem2.PEntrez.Pubmed.Pubmed_ResultsPanel.Pubmed_DiscoveryPanel.Pubmed_RVAbstractPlus
http://www.ncbi.nlm.nih.gov/sites/entrez?Db=pubmed&Cmd=Search&Term=%22Heaton%20KW%22%5BAuthor%5D&itool=EntrezSystem2.PEntrez.Pubmed.Pubmed_ResultsPanel.Pubmed_DiscoveryPanel.Pubmed_RVAbstractPlus
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